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ADOBE'S
VISUAL TRENDS
FOR 201/

> To help designers and
photographers keep
abreast with current styles,
Adobe has compiled a list of
10 trends for digital media in
2017, While there's a heavy
emphasis on the stock factor
(understandable with Adobe

i pushing its stock integration

i features within Photoshop

: and across the Creative Suite)
| it'sstill aninteresting list,

i as it seeks to predict where
photography and digital

. imaging is heading in the

i future. Current technological

i advances have aheavy

. influence, with inclusions of

. aerial photography guided by

. drones and 3D tools. Finally,

. perhaps inresponse to an

. overly industrialized world, we
are also seeing more delicate

i art. Here are our picks...




#1 AERIAL PHOTOGRAPHY

Aerial photography has reached new heights

since the invention and popularization of drones. |

We can now produce images from viewpoints
that were never before possible.
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#3 TABLET ART

In a technology-focused world, it's natural to
respond with a gravitation toward handicraft.
Tablets and responsive pens allow artists to
create ever more realistic and detailed art.

#2 3D IMAGING

3D tools and design applications are growing,
and innovative tools are simplifyinghow 3D is
used. With tools like Project Felix, creating 3D
designs and artwork is easier and quicker.

#4 STORYTELLING

Images designed to narrate a full story will
always be popular, especially in our social media
age. Stories are far more effective than agreat
composition or perfect lighting.




#5 UNBALANGED COMPOSITIONS #6 CINEMAGRAPHS

One way images can stand out from the Boomerangs and cinemagraphs converge
crowd is with an unbalanced composition. When | photos and video by creating perfect loops,
designers search stock libraries it'll be the photo | capturinga moment in time. The majority of the

from an unusual or tilted angle. photo is still, with one moving element.

#7 SIMPLICITY #8 GENDER ROLES

2016 was a year filled with uncertainty. This This trend celebrates women and their
year, the world is ready for simplicity and truth. creativity, notable figures in the creative
Inart, that translates to getting back to nature | field, and contemporaries who are ever

and considering how we relate to the Earth. expanding their influence.




Discover how to breath new life into
your old or damaged photos with these
essential skills and techniques

b Many of us have old
photo albums full of

cherished family portraits
and familiar faces - and
inevitably some of them will
have become damaged or
faded over time. But if you
can digitise them (either with
a scanner or by taking a photo
of the print) then you can
bring them into Photoshop
foranew lease of life.

Over the next few pages,
we'll explain how. You'll learn
essential tricks like fixing
scratches, rebuilding ripped

i prints and enhancing faded

i prints; then we'll take it a little
: further and show you a few

i creative techniques to try out
: onyour photos.

Evenif you haven't gota

. setof old family photos that
i aredigitised and waiting to
be lovingly restored, you'll

i still find plenty of advice

i forimage-editing that goes

. beyond restoration work -

i from essential retouching
 skills to great tips for tidying
i photos, controlling noise and
i creating amazing artwork...
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Photoshop
PART1

THE GHALLENGES
OF RESTORATION

Eight typical tests for the photo restorer - and how to solve them...
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01 SCRATCHES AND MARKS

Surface damage to prints like scratches, blemishes, grime or spots is easily removed with the
Spot Healing Brush tool. Set the tool to Sample All Layers in the tool options at the top, then
click the Create New Layericon in the Layers panel to make a new empty layer for your healing.
Paint over problems to remove them. If things go wrong, undo with Ctrl/Cmd+Shift+Z, then try
using the Healing Brush instead. It works in a similar way, except you need to Alt-click to define
a source from a clean area of similar detail nearby.

-------------------------------------------------------------------------------------------------------------------------------------------------
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02 LOST PARTS

Unfortunately, old prints are
delicate and brittle. Irreparable
rips can happen over time, but
even missing details like the
ripped face here can be rebuilt,
as long as the parts that remain
can be used to cover up the
problem patch.

Selecttheintact part with the
Lasso tool and duplicateittoa
new layer with Ctrl/Cmd+], then
press Ctrl/Cmd+T to transform.
Right-click the area and choose
Flip Horizontal, then positionitin
place to cover the missing part.
Next, click the Add Layer Mask
icon in the Layers panel, then
use the Brush and paint black
toblend the edges.



03 MISSING CORNERS

Luckily missing faces are rare, but missing
corners are much more common. The solutionis
similar to before: either paste over with existing
details, or generate new pixels with Photoshop's
Content-Aware tools. For missing corners like
this, the first option is usually the most effective.
Selectan area with the Lasso tool, then
right-click the selection and choose Feather. Set
Radius to about 12. Press Ctrl/Cmd+| to copy the selection to a new area, then use the Move
tool to position it over the empty space. If you need to fine-tune what's visible, add a layer
mask, then paint over the area with the Brush set to black to hide parts of the new layer.
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(14 WASHED
OUT SHADOWS

You'll often see shadows
become very faded in old prints,
particularly monochrome images
like this. There's a very quick fix:
press Ctrl/Cmd+Shift+B. This
applies Auto-Color (it's also found
under the Image menu), which
often results in punchy shadows
and better contrast. If it's too
strong, press Ctrl/Cmd+Shift+F
for Fade - a handy command that
lets you fade out your last edit.
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05 CREASES

Creases are more difficult to remove than scratches or marks, because they usually go from
one edge of an image to the other. Running across the entire length with the Spot Healing
Brush tool might look messy and obvious, especially if there are lots of varied details along the
crease. Instead, tackle the crease in segments: make a new layer, grab the Clone tool (set to
Sample: All Layers), zoom in close and repair the damage bit by bit, sampling clear areas nearby.



06 FLAT FAGES

Old prints can lack contrast, and faces often look flat. They can be improved with a little
dodging and burning to add depth and emphasise the form of the face. In principle, it's the
same kind of tasks retouchers will carry out on modern portraits: lighten the middle of the

forehead, the bridge of the nose, the whites of the eyes and the chin; then darken under the
cheekbones, the outline of the nose, the hairline and the neck. Carry out your dodging and
burning on a duplicate layer, with the Dodge tool set to either Highlights or Midtones at no
more than 20%, and the Burn tool set to Midtones or Shadows, again at 20% or less.
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07 COLOR GASTS

Over time, color prints will often develop
severe color shifts - commonly ared cast like
you can see in this image. This is a fairly easy
fix. Right-click the image in Bridge and choose
Open In Camera Raw, then grab the White
Balance tool from the toolbar. Click over a
point in the image that should be neutral and
lacking in any color, like the baby’s white vest
here.

This should fix the cast, but if
not, try clicking elsewhere or use
the Temp and Tint sliders to fine-
tune the colors. If a strong cast
still persists, grab the Targeted
Adjustment Tool from the
toolbar, right-click and choose
Saturation, then drag down over
the dominant color within the
image to reduce it.



08 SOFT
DETAILS

One of the big problems
you find with old printsis
that theyre often lacking

in fine detail, especially

if the originals are small.
Unfortunately there's no way
to addin extra detail, but you
can enhance what's there.
One way to do thisis with a
combination of sharpening
and noise reduction, using
Camera Raw's Details panel.
However, the results of heavy
noise reduction can leave
images looking a little mushy.
The solution to this problem is
to add a little extra grain using
the FX panel in Camera Raw.




Photoshop

TOP10
THE RESTORER'S TOOLBOX

Get to know the 10 best tools Photoshop
offers for repairing old photos

Fill B ' Dust & Scratches

Contents: Content-Aware v

Options
Cancel
Color Adaptation
Elending
Mode: Normal v Q 0% @
Opacitsr: % : Rackis:[1__ ] ptuss

| Preserve Transparency

------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

01 CONTENT-AWARE FILL ~ 02DUST AND SCRATCHES

Thisis useful for filling in missing portions of a :  Found under Filter > Noise, the Dust and Scratches
print like corners or uneven sides. Make aduplicate | filter helps you clean up small marks and blemishes
of the background layer, thengrab the Polygonal |  across yourimage (or an active selection). Like all
Lasso tool and click a loose selectionoverthearea. |  blanket fixes, it can be heavy-handed, but used

Go to Edit > Fill and set Use: Content-Aware. discretely it can halve your retouching time.
A quick fix for missing A quick fix for large problem areas beset
parts of a print. with small marks and scratches.
It's effective, but rarely perfect: you'll usually Can leave details looking soft and
need to tidy up by cloning or healing. mushy if over-used.

Duplicate the layer and erase the subjectbefore i Use Threshold to control what's detected as a mark
using Fill, so that it only samples from what's left. while keeping natural image noise intact.



03
SPOT HEALING |
0L

This is a great tool for |
restorers. Paintover
marks, scratches and
dirt, and it'll fix the
problem by sampling
nearby pixels. It's
besttouseitona
new empty layer
with the tool set to
Sample All Layersin
the tool optionsat
the top. This way, the
retouchingremains |
non-destructive.

Quick and easy -
itworks just like
abrush.

04
PATGH
T00L

This is good for larger

problem areas like
flaky paper, wide
scratches or dirty
streaks. Drag aloose
selection over the
area, thenmoveitto
a clean area nearby.
Experiment with
different Structure
and Color settings
in the tool options

paint to clone the area.

. arealsomore in-depth |

at the top forthe most |

effective results.

o |

It's similar to the Spot

Healing tool, but you
choose the area.

05
GLONE
100L

A powerful optionfor |
: photorestorers.Hold
i Altand click to sample |

acleanareanextto
the problem, then

You can set the tool
to Sample All Layers,
S0 you can clone on

an empty layerabove

your original. There

controls in Window
> Clone Source.,

Effective, simple to
use and easy to see
exactly how it works.

06
HEALING
BRUSH T0OL

Good for tidying
scratches and marks,
this is very similar
to the Spot Healing
Brush. The one big
differenceis that
you must Alt-click
to sample a source
before healing. So
it's slightly more
laborious, but useful
for when the Spot
Healing Brush

slips up.

Good for spotting;
lets you sample
a source,

o i o

@

It can mess up around
edge areas or smudge
fine detail.

T0PTIP

Hold Shift and click
between two points
to heal in astraight
line - great forlong
scratches and creases.

)
e —————
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&

‘Content-Aware’mode

is of ten less effective |

than'Normal.

TOPTIP

i
e ————
"

Set Patch to 'Content

Aware'and you can

Sample All Layers -

S0 you can patchon
anempty layer.

&

More laborious than
Content-Aware tools,

but more predictable.

The Clone tool often
works best at low
opacity, as youcan

gradually clone away

messy areas.

TPTP

. Setting the Sample to

Often the Spot
Healing Brush gives
you the same result.

T0PTIP

Current And Below is

useful when you have
. Adjustment Layerson
i top of your layer stack.



08
FAGE-AWARE
LIQUIFY

i This tool can be useful i
if you need to rebuild
part of a missing
face by flipping the

07
SHARPEN
T00L

Sometimes when
you apply universal
sharpening toan
old print, it sharpens

the print texture and other half. Perfectly
grime rather than symmetrical faces |
the details. When canlook abitstrange, |
this happens, try however, sousethe |

selectively painting : Face-Aware controls

withthe Sharpentool. | inFilter > Liquify to

slightly skew the
eyesormouth-use
reference fromother |
photosif you have it.

On an empty layer, set |
the tool to Sample All
Layers with Strength

ataround 20%.

Muchbetterthanit { Detectsfacesand !
usedtobe;letsyou : facialfeaturesandlets :
paint in sharpening. you alter them.

DODGE AND
BURN TOOLS

The Dodge and
Burn tools let you
selectively lighten
or darken areas of

your photos. They're

particularly useful for |
emphasizing detailsin |

faded photos, as you

. canburnthe shadows |

and dodge the

highlights to increase |
contrastand punchin |

the mostimportant
areas of the picture.

Lets you control
how the shadows, or

. highlights will behave.

10
DETAIL

The Detail Panelin
Camera Raw (and
under Filter > Camera
Raw in Photoshop)
is the best tool
Photoshop offers
for noise reduction
and sharpening. Old
prints are often soft,
so use sharpening
and a high radius to
pull out detail, then
compensate with
the noise reduction
Amountslider.

Lets you apply very
effective sharpening
and noise reduction.

B B O e B B B B B B B B B e e e N T T ETEETS ST Er

&

Can look rather
unsettlingly fake
if overdone.

&

Can lookaalittle heavy- :
handed if over-done;
use a separate layer.

)
e —————
"

TOPTIP TOPTIP

Keeping Protect When there are
Detail checked in the multiple facesina |
tool options helps photo, you can target

. themindividually with |
the Select Face box.

to prevent heavily
pixelated artifacts.

i
e ————

These are destructive

tools that alter pixels
permanently.

Hold Alt while using
the Dodge tool to
temporarily switch
to the Burn tool,
and vice versa.

TOPTP |

. Use Masking to control

Some sliders may
appear not to have
much effect.

TOPTIP

what's sharpened or
not - hold Alt while

dragging the slider to
see what's masked.



Photoshop
PART 3

HAND-GOLOR
YOUR OLD PHOTOS

Here'sa
simple, non-
destructive
way to give
your old photos
a hand-painted
look with
selections and
Adjustment
Layers...

. »» DOWNLOAD THE PROJECT FILES HERE http:/tiny.cc/7wzdjy ON YOUR PCORMAC 44



[" SELECT

THE JACKET

Grab the Quick Selection
tool from the Tools panel
and paint over the jacket
(or any portion of the
image to be singularly
colored). Hold Alt to
subtract if the tool goes
wrong atall. Togeta
smoother edge, go to
Select > Select And Mask
and increase the Radius
and Smooth sliders.

R i e s [ TINTTHE AREA

o | | Go to the Layers

' panel (Window >

Layers) click the Create
Adjustment Layer icon at
the bottom, and choose
Color Balance. Experiment
with the sliders to add
a tint. For extra control,
target the Highlights,
Midtones and Shadows
and experiment with color
shifts. Try unchecking
Preserve Luminosity too.
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[l COLOR THE FAGE
Highlight the

bottom layer, then make
a selection of a different
area. We've selected

the skin (except the lips,
eyes and eyebrows).

For a nice skin tone, we
set Midtones: Cyan-Red
+29, Yellow-Blue -12.
Highlights: Cyan-Red +2,
Yellow-Blue -8. Shadows:
Cyan-Red +11, Magenta-
Green -4, Yellow-Blue -6.
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Continue selecting e .
other areas of the image
and coloring themin
different ways, naming
the layers for parts of
the faceasyougo. If you
need to fine-tune an area
that's covered, highlight
the mask thumbnail of
the corresponding Color
Balance layer, then paint |
with white to reveal more 3 o E——
color or black to hide it. L m—— s
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Onceall parts are done,
tweak the settings until
B everything gels. If you
2 need to tone a color down,
lower the layer opacity
of the Color Balance
— layer. To strengthen
a color, duplicate the
Color Balance layer
= with Ctrl/Cmd+]. Here
- we duplicated the skin
S and lips layers.
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To sharpen and enhance
the details, highlight the
top layer then press Ctrl/
Cmd+Shift+Alt+E to
merge a copy of all layers.
GotoFilter > Camera Raw
Filter. Use the Basic tonal
controls to add contrast.
Next, go to the Detail
panel. Apply Sharpening
and Noise Reduction to
finish off the image.
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PART 4

FILTER FIX

Use the Dust and
Scratches filter
selectively and at
different strengths B
toquickly cutthrough
grime and fixphotos

FIX THE TONES

Right-click your
image in Bridge and
choose Open In Camera
Raw, then use the tonal
sliders to enhance the
tones and pull out detail,
as shown. Next, open the
image in Photoshop, make
anew layer and use the
Spot Healing Brush tool
(set to Sample All Layers)
to fix the larger marks
and blemishes.

. »» DOWNLOAD THE PROJECT FILES HERE http:/tiny.cc/7wzdjy ON YOURPCORMAC 44



02 APPLY

THE FILTER

Press Ctrl/Cmd+Shift
+Alt+E to merge a copy
of all layers. Right-click
the new layer and choose
Convert to Smart Object.
Go toFilter > Noise > Dust
And Scratches. Zoom

in and experiment until

it looks clearer. Radius
controls strength, while
Threshold controls what
size marks are included.
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U ANOTHER FILTER
Press Ctrl/Cmd
+Shift+Alt+E to merge
a new layer, thengo to
Filter > Noise > Dust And
Scratches. Tweak the
settings to suit the faces;
here we're at Radius 4,
Threshold 8. Add afull
black layer mask then
paint with white to reveal
the effect over the faces.
Continue in the same way
to finish the restoration.

rioB0r s At b S d LD

e l] PAINT A MASK
Here Radius 31,
Threshold 14 has cleared
the background nicely,
but it's left other details
looking smudgy. So click
0K, then click Alt-click the
Add Layer Mask icon in the
Layers panel to hide the
effect behind a full black
mask. Grab the Brush tool,
setits color to white, and
paint over the backdrop
to reveal the filter effect.
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Give your old portraits a whole new lease of life or use them to
create some original artwork, with these fabulous project ideas

TAPHEHE 0
SEE vmm
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. »» DOWNLOAD THE PROJECT FILES HERE http:/tiny.cc/7wzdjy ON YOURPCORMAC 44
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Open animage, go to the Layers panel (Window > Layers) and click the New Layer icon.
Choose Color from the Blend Mode drop-down menu. Now grab the Brush Tool, choose
a color and start painting. Use a separate layer for each element, and adjust the layer

opacity to mute the colors. If an area looks too bright, make a duplicate of the color layer
and set the Blend Mode to Multiply, then use a low-opacity layer to darken.



Photoshop

dpacity:
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TAKE A SURREAL APPROACH

Why not subvert the subject matter? For an effect like this, open animage and add a

layer mask, then grab the Brush tool, set its color to black and paint to hide the face.
Press Ctrl+] (or Cmd-+) in macOS) to duplicate the layer, and drag it below the first layer.
Press Ctrl/Cmd+T to transform, then resize and position in the empty space. Duplicate
and resize again. When you get to the center, discard the bottom layer’s mask.



Photoshop

MAKE A COLLAGE

If you can't decide which old photos to display, why not make a collage? Use the Quick
Selection tool to select a person, then press Ctrl/Cmd+] to duplicate. Use the Move
tool to drag elements from one image to another, then piece together the separate
elements into a pleasing whole. (Check Show Transform Controls and Auto-Select
Layer in the tool options to make moving and resizing easier.) You can use the same
method to create all kinds of retro montages.
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Photoshop
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CREATE BHUSH-BASED ART
You often see this kind of brush effect on posters and book covers. Start by downloading
messy brushes like the watercolor brushes we've used here, found on the Creative Cloud
App’s Assets area. Make a new layer, set the Blend Mode to Multiply, then start dabbing the

brushes, using the Brush panel to alter the angle of the brush tip for variation. You can also
drop in textures (set their Blend Mode to Multiply) and blend in other color effects.



TAP HERE T0
SEE VIDED <

aS
TAKE GONTROL OF
YOUR RAW FILES

Control the mood and atmosphere of your raw files with a few
simple Camera Raw tweaks. Here are four easy effectsto try...

APPLY PICTURE STYLES TO RAW FILES

Have you ever noticed how if to get yourraws lookingjustas | Camera Vivid and a Canon CR2
you shoot with yourcameraset @ vibrant... . offers Camera Faithful.
to Raw+|PEG, the |PEG canlook Tucked away in Camera After you openanew

more vibrantthanthe raw? This | Raw'sCamera Calibration panel, | image, it's often worth heading
is because the JPEG has a picture | the Camera Profile drop-down . straight to Camera Calibration to
style applied toitin-camera, . lets you choose from a range - experiment with these profiles:
boosting color and contrast, while:  of familiar styles. The list will - they offer a variety of looks that
the raw file is left untouched. . depend on your camera - for : can make a good starting point

But there's aquick andeasyway | example, a Nikon NEF file offers | for further edits.

~ »»DOWNLOAD THE PROJECT FILES HERE http://tiny.cc/7wzdjy ON YOUR PCORMAC44
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PRACTICAL

Photoshop
01 THE NATURAL LOOK

500 Wk mm

Hazic

White Dalsnce:  Cwwiom

Tempenate

B 1200

A0 108 mm

SEMEShHAOER

Tempersture

Foranatural
portrait, begin by
fixing any color casts
in the photo. Grab
the White Balance
tool from the toolbar
and click overa
neutral tone. Next,
adjust Exposure and
tweak Contrast until
the tones look bright
and punchy. To make
full use of the tonal
range, hold down

Alt and drag Whites
and Blacks for a
grayscale view that
shows clipped pixels,
stopping just short
of where they begin
to appear.

You canuse the
Basic panel’s sliders
to give portraits

a cool, desaturated
look. Begin this
effect by dragging
Temperature to the
left to cool down
the image, then
tweak Tint. Next, try
lowering Saturation
to partially drain

the image of color -
you can getsome
interesting effects
by boosting Vibrance
too. Togive the
image a stylized look,
increase Shadows,
decrease Highlights
and pump up Clarity.



Photoshop

03 GO RETRO

Go tothe Tone Curve
panel, click Point
and target the Blue
channel. Drag the
bottom-left point
up and the top-right
point down to tint
the shadows blue
and the highlights
yellow. For a film
border effect, grab
the Graduated Filter
and set Exposure to
-4.0, thendrag short
gradsinfromeach
side. For alight leak
effect, load the tool
with an orange color
and +100 Saturation,
thendragin from
one side,

Grab the Targeted
Adjustment tool
from the toolbar,
right-click and
choose Grayscale
Mix. This will convert
to black and white
and let youdragup
or down over the
image to alter color
brightness. Fora
sepia effect, goto
the Split Tone panel.
You can Alt-drag
the Hue sliders for
a temporary view
of shadow and
highlight tinting at
100% Saturation.
Dial in saturation
to suit.
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TAP HERETO

JUINEDATTRELIP &

James Paterson takes inspiration from a famous artist’s technique
and explains how to piece together a portrait collage

pp Backinthel980s,artist | stilllifeintheeffectithasonan

David Hockney started i everyday scene. )

o bemirh : . You'lllearn
piecing together Polaroids into i Tobegin, we shoot a set of M Create acollage by
collages that showed a subject i portraits taken from different piecing together cropped
from multiple angles. Hockney’s | angles. Then we can either photosofaface
‘joiners’ captured the public i arrange our collage in Photoshop, E;I:;“ "E::d
imagination and made him | piecing the images together, or it bl e
a household name. i take the old-school approach

. : : L Itll take
Since then the techniquehas : by printing out the photos and M 0ne ol

been much imitated - butthere’s | arrangingthem by hand.

. »»DOWNLOAD THE PROJECT FILES HERE http://tiny.cc/7wzdjy ON YOUR PC OR MAC 44
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GAPTURE THE SET OF IMAGES YOU NEED TO CREATE

CAMERA CONTROLS MOVE AROUND SUBJECT MOVEMENT

WHITE WALL SOFT LIGHT Z00OM LENS



Photoshop

STEP BY STEP
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n CONVERT ALL IMAGES TO MONO ﬂ COPY AND PASTE

In Adobe Bridge, right-click an Open animage. Select a portion

image and choose Open In Camera Raw, with the Rectangular Marquee tool, then
then convert it to mono. Click Done. press Ctrl/Cmd+Cto copy. Go to File >
Right-click the image, choose Develop New and make a new A3 document with a
Settings > Copy Settings. Select the white background. Paste in the selection.
otherfiles, right-click and select Develop In the Layers panel, right-click the layer
Settings > Paste Settings. and select Convert To Smart Object.
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n RESIZE AND POSITION [l CREATE SHADOWS

Select the Move tool, check Show To finish, we'll add shadows.
Transform Controls and Auto-Select Layer Double-click any layer to open the Layer
in its options. Move the piece roughly into Styles box. Highlight Drop Shadow, then

position and click the corner of the box adjust the settings to tweak the shadow
if you need to resize. (Hold Shift.) Open size and position. Once done, hold Alt and
anotherimage, select an piece, paste it drag the drop-shadow effect from one

in and position again. layer to another to copy it.
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When you resize a pixel-based layertobe i Ina project like this there are several ways
smaller, you're effectively throwingaway : tocreate your montage. Using Snapshots,
pixels, whichis a problem if you decideto | you can easily save a point in your workflow,
go larger again. However, if you right-click then go back to it later if you choose. Create
it and choose Convert To Smart Object, you | a snapshot from the History panel; it'll
can resize with no loss in quality. appear at the top of the panel.

MAKE PRINTS SETUP A COPY TABLE SHOOT THE PRINTS
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Photoshop

1N LHTROON

All Photographs
.................

O

TAP HERE TO
SEE VIDED

. 2 This month, find out how to
- | make quick, simple edits in
the Lightroom Library

«[f you'd like to watch the
complete course now, get the
app from the Apple App Store

Thor Likwary Frsba e

TAP HERE TO GET THE
FULL LIGTROOM APP TODAY
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SOENTIALS

Your quick-start guide and reference
to Image editing in Photoshop

_‘__—J'

If you're relatively new to editingin typical image-editing workflow in Photoshop;
d Photoshop, or you just don't know an overview of raw file editing; a quide to the
where to begin, then this sectionis the best sixmost useful layers; and a glossary of the
place to get started. Over the next nine pages, most useful shortcuts. This guide condenses
you'll find an overview of the different versions = most of the tools and technigues you'll use
of Photoshop available; a breakdown of the every time you import a new roll of pictures.
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PHOTOSHOP GG

WINDOWS, mac0$

_ and non-professional photographers. Beyond the standard
photo-editing features, it boasts a vast array of more
creative tools and filters. Layers are one of the key differences
between Photoshop and Lightroom. They enable you to mask out
selected parts to build up increasingly sophisticated images.

ﬁ Photoshop is the software of choice for most professional
e,

] ;

F
B
E
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x E O|
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.45 WINDOWS, macO$
Elements is the consumer variant of Photoshop, and
contains many of its key tools and features withina
simplified interface. It's limited, but it does provide access
to layers for those who have switched to a Lightroom workflow.

lIBHTHI]I]M b

WIHDI]WS mac0S

Lightroom combines
the professional raw-

processing tools in the
more expensive Photoshop
CCwith the asset-organizing
powers of the cheaper
Photoshop Elements.
Lightroomisavailable as
a traditional boxed copy
(Lightroom 6), and as part of
a Creative Cloud subscription
(Lightroom CC). Essentially,
the applications are the same,
except Lightroom CChas
Creative Cloud support, ongoing
updates, and access to the
mobile and web workflows.

LIGHTROOM MOBILE

IPHONE, IPAD, ﬂHI]Hl]II]

Lightroom Mobile is
the lightweight iPad,
iPhone and Android

version of the application,
integrated with Lightroom CC
butnot Lightroom 6. To use
Lightroom Mobile you need

to signup foran Adobe ID so
that you can access the Adobe
Creative Cloud. This enables
you to create a collection

of photos on your desktop
copy of Lightroom and sync
them via the Creative Cloud

to Lightroom Mobile on your
portable devices. You can then
use Lightroom Mobile to edit or
add ratings to your pictures.
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ADOBE PHOTOSHOP MIX

IPAD, ANDROID

. Mix enables you to merge two photos together

\ to create a composite image. It offers a simplified

¥ compositing process that makes it easy for beginners
to start combining an object from one image with a background
from another. You can then send the composite to Photoshop
for further edits. If you like, you can also use Mix to edit a single
image. It offers a few simple tonal adjustments and more
complex edits such as Content-Aware Fill.

ADOBE COLOR

IPHONE, IPAD, ANDROID

b If you ever need help
Pl selecting coordinated colors
Y for your designs, try using
Aduhe Color. Itenables you to create
color themes from photos taken on
your mobile device. This could be
anything from a scene in your local
park to a famous painting. So if you
come across an inspirational scene,
capture the colors and save them.

_} ADOBE SHAPE

IPHONE, IPAD, ANDROID

Adobe Shape enables
you to turn photos and
sketches into beautiful
vector shapes for use in your
designs or artwork. The app
smooths out jagged edges in
images, resulting in gorgeous
vectors that are endlessly
scalable, just asif you'd drawn
them by hand with the Pen tool.
Make a shape with the mobile
app and the next time you open
Photoshop on your desktop, the
shape will sync to your Library.
Dragitintoanydocumentto
add color and make further
adjustments.

ADOBE BRUSH

IPHONE, IPAD, ANDROID

s Adobe Brush enables
you to make your

¥ own custom brushes
frDm photos or sketches for
use in Photoshop, lllustrator
or the Sketch app. The most
successful subjects are usually
those that can be easily
isolated, such as asplash
against white, or a leaf against
the sky. You can capture objects
for your brush tips using your
device's camera, choose from
your cameraroll, or use your
Creative Cloud library. Once
captured, you can then fine-
tune the look of the tipand
apply brush settings.
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ADOBE PHOTOSHOP SKETCH

IPAD
As the name suggests, this app enables you to paint
freehand using a selection of brushes, colors and other
s tools. However, Sketch is more than just a painting
app. It also enables you to connect with like-minded creatives,
so you can follow artists and see their work updating. Once
you'e done sketching the image on your iPad, you can upload
to the Sketch community or continue working on the image
in Photoshop CC. You can also bring in brushes made with
Adobe Brush, and for those who can't paint, there’s an option
to overlay images so you can trace over a photo. Sketch s
compatible with Adobe's pen and ruler hardware, Ink and Slide,
but you can get great results with your finger.

PHOTOSHOP FIX

IPAD

Fix is a retouching app
for altering portraits and
fixing marks or blemishes

inyour photos. Intelligent facial
recognition locks onto eyes, lips
noses and chins, making it easy to
tweak a smile, tuck in ajawline or
enlarge eyes, should you wish.

ADOBE COMP CC

IPAD

If you're a designer
who wants to build

a quick layout fora
web or print page, then Comp is
theideal place to start piecing
ideas, images and text together.
You can draw common design
elements such as text orimage
boxes with quick gestures. For
example, a couple of squiggly
lines with a dot makes a
header, and a cross makes an
Image box. ltmakes it easy to
mock up a layout in seconds.
You can then add words and
graphics. The app even spits
out aPhotoshop, lllustrator or
InDesign document.

BEHANGE
CREATIVE PORTFOLID

IPAD, IPHONE

Behance is the online
3@ | social space for
creatives to share

and showcase their portfolios,
connect with one another,
and find work, With work
from the best photographers,
digital artists and designers
outthere, it'salsoaqgreat
place to find inspiration for
anew project. If you're a
Creative Cloud subscriber you
cansetup aBehance pagein
minutes. The Behance app
foriOS devices enables you to
manage your page, while the
Creative Portfolioapp provides
a polished portfolio.




BB THE IMAGE-EDITING WORKFLOW

Manage your photos from capture to outputin three stages

The image-editing process begins as
soon as you've transferred your photos
from your memory card to your computer,

The first stage is to begin sifting
through your pictures to discover which are
the keepers. The image organizer that comes
with Photoshop is ideal for this task. Adobe
Bridge has controls for keywording, rating and
filtering yourimages, and there are handy tools
for batch renaming files, creating panoramic
stitches, making contact sheets and more.

Launch Adobe Bridge and navigate toa
folder containing new images. Use the cursor
keys to quickly flick through the images and
click below a thumbnail to add a star rating, or
use the keyboard shortcut Cmd/Ctrl+1-5. You
can then filter your images by the starrating to
group the ones you want to work on.

The next stepis to open the images
from Bridge into Adobe Camera Raw. ACR
is the best place to make initial changes to
your images to boost tones and correct any
problems with exposure and so on. ltdoesn't
enable you to combine images - you'll use
Photoshop for that - but it does enable you to
make the kind of edits photographers need.

In Photoshop, you can further refine
the image with layers and adjustment layers,
which offer amuch more flexible way of
working than ACR. Once you've finished, it's
time to share it with a wider audience. Go to
File>Save, and yourimage will be saved as a
Photoshop document (PSD). This keeps all the
layers intact, which means you can go back and
retweak the image at a later date. However,
PSD files are large and take up lots of hard drive
space. If you want to share your images online
or via email or social media, save them as |PEGs.

i
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B THE BASIGS OF RAW PROGESSING

Discover how to process your raw files to perfection

The latest version of the raw file

processor included with Photoshop is so
powerful that most photos can be processed
entirely in the raw processor, with no need for
further editingin Photoshop. And by making
your adjustments in Adobe Camera Raw

THE BASIC
PANEL IN ACR

TEMPERATURE

Use this slider to warm

or cool animageif the
White Balance tool fails to
correct a color cast

TINT

Thisslider enables you to
correct agreen or magenta
cast, again, if the White
Balance tool fails

EXPOSURE

Controls the overall
brightness of the image

BLACKS

Sets apointon the tonal
range at which pixels
should be pure black

&7 AEIS A @

Basic

White Balance: [As Shot

it

Temperature

%

T

Tint

i

Exposure [+0.90
Fﬁ:— In_-
ﬁ |n_,

%

WLL

%

SATURATION

Controls the overall color
intensity of the image

rather than in Photoshop, you'll ensure the
best possible image quality, because raw files
contain more picture information than bitmap
images such as un-layered PSDs and |PEGs.
Here's our reference to the features you'll use
the most in the Basic panel.

CONTRAST

Makes light pixels brighter
and dark pixels darker

HIGHLIGHTS

Controls the brightness
of the lightest pixels

SHADOWS

Controls the brightness
of the darkest pixels

WHITES

Setsa pointonthe tonal
range at which pixels
should be pure white

GLARITY

Controls the amount
of midtone contrast

VIBRANCE

Adjusts theintensity of
the less-saturated colors



B SIX ESSENTIAL LAYERS FOR PHOTOS

The six most frequently used Photoshop layers forimage
editing, and how to use them to improve almost any photo

Photoshop has many types of layers

and adjustment layers available, but
there are six that you'll find you need to use
again and again. Learning how they should be

-------

CURVES

u Curves is one of the most powerful
adjustment layers. An S-shaped curve
brightens the highlights and darkens the
shadows, resulting in extra contrast. Create
a Curves Adjustment Layer and click the
middle of the diagonal line to add a central
control point. Drag down on the lower part
of the line and drag up on the upper part of
theline to improve image contrast.

used may seem a little daunting for beginners,
but once you've got to grips with them, you'll
find they play a part in the creative process of
almost every image you make.

ﬂ LEVELS

This should be the first layer you add
to animage, because it fundamentally alters
the tonal range of the entire image. Create

a Levels Adjustment Layer, drag the Black
Point slider inwards until it touches the left-
hand edge of the histogram, and drag the
White Point slider inwards to the right-hand
edge. This remaps the tones of theimage to
make more of the available tonal range.
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HUE/SATURATION

[]3 This adjustment layer is best used
for altering the intensity and brightness

of individual color channelsinanimage -
greens and blues in landscapes, for instance.
Create a Hue/Saturation Adjustment Layer,
click the Master menu and choose the color
channel you'd like to adjust. Small changes
are usually the most effective.



HEALING LAYER

u Most photos contain unwanted
marks or blemishes. The Spot Healing Brush
tool s effective at removing these. The best
way to apply the healing is on a new blank
layer, so that you can easily tone down or
remove selected healing work later without
having to start from scratch because you
healed directly on the background layer. To
do this, create a new blank layer, choose the
Spot Healing Brush tool from the Tools panel
and tick Sample All Layers on the Options
Bar, then continue as normal.

S AFTER  BEFORE |

[l DODGE AND BURN

One of the best ways toenhancea
photo is by lightening or darkening selected
areas of the image. This can be done with

= the Dodge and Burn tools, but rather than

SELECTIVE SHARPENING

U Once all other adjustments have
been made, you need to sharpen the image
for output. The traditional way is to create a
merged layer at the top of the stack, apply
Unsharp Mask, then paint on the mask to
remove the sharpening from those parts

of the image you want to remain soft.
However, the Sharpen tool enables more
control over the process by enabling you to
build up the effect by brushing repeatedly
with alow opacity brush. Create a new blank
layer, select the Sharpen tool, tick Sample All
Layers and set a Strength of 50% or lower.

use them directly on theimage, a separate
grey layer gives you greater control. To
create a Dodge and Burn layer, hold down
Alt and click the Create a new layericonin
the Layers panel. Give the layer a name,
then choose Mode: Overlay. Check Fill with
Overlay-neutral color and click OK. Now use
the Dodge and Burn tools (with Range set to
Midtones) to work on the new layer.

e TOIH
= Opacity: 100% =

All: 100% =



o 14 ESSENTIAL
KEYBOARD SHORTGUTS

14 keyboard shortcuts that will massively improve your
speed and efficiency while working in Photoshop

D

Reset the foreground and background colors
to black and white

ALT+[SCROLL WHEEL]

Zoom in or out of the image

CMD/CTRL+SHIFT+ALT+E

Create a merged copy of all the layersin the
layer stack

SPAGE BAR

Temporarily switch the current tool to the Hand
tool, for moving around the image while zoomed in

ALT+[EYE ICON]

Switch off the visibility of all other layers in the
layer stack, for before-and-after comparisons

CMD/CTRL+l

Invert the color of a layer mask to black

SHIFT+{LAYER MASK]

Disable the effects of alayer mask

X

Switch the foreground and background
color swatches

[OR]

Resize the brush tip

SHIFT+{ OR ]

Cycle backwards or forwards through the
layer blend modes

CMD/CTRL+ALT+Z

Undo the last change made to the document.
Works multiple times

CMD/CTRL+[LAYER MASK]

Load the currently active layer mask as
anew selection

CMD/CTRLT

Activate the Free Transform tool

GMD/CTRL+J

Duplicate the current layer
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Now’s the time.
Buy the B1or B2.
Get an Airremote
for free.

Buy a B1 or B2 Off-Camera Flash kit before April 30, 2017
and get any of the Air Remote TTL (for Canon, Nikon or

Sony) or Air Remote for free. @ Profoto

profoto.com/offcameraflash/find-dealer The light shaping company™
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WELCOME

One of the biggest photography events in Europe, big
name photographers, manufacturers, distributors,
retailers, passionate pros and keen amateurs convene
at the NEC in Birmingham for The Photography Show.

The Photography Show is a unique chance to try out the hottest new cameras
and accessories, hear top photographers share their insights and secrets, see
stunning images galleries, and snap up exclusive retailer show deals.

Plus, pay the normal rate for your first day and get the other days half price

- see www.photographyshow.com/registration for details. What's more,
verified professional photographers and trade representatives can get in free
on all days, while students go free on the Tuesday (with a concessionary rate on
Saturday, Sunday or Monday). See our website too for discounts on train tickets
and on hotels.

We have lots of new features this year, as well as old favourites. Check out our
new Drone Zone with its programme of flying displays and practical demos.
Learn about the new world of 360° photography at our VR theatre. And check
out our expanded programme for professional photographers.

There are hundreds of free talks to choos from, but there are some extra

special events to sign up for too, such as the Pro Conference, the Beginner’s
Masterclass, and the Turning Pro Masterclass. Plus there are nine megastars on
our special Super Stage. Book your tickets to see them now, and see you there!

Chris George

Group Editor-in-Chief
Digital Camera, FhotoPlus, Digital Photographer, N-FPhoto,
FPhotoshop Creative, Practical Photoshop, Photography Week

KEEP UP T0 DATE WITH THE FREE APP

so keep up to date by downloading the free official show app onto your
smartphone or tablet. Search the Apple App Store or Android Google
Play for The Photography Show 2017.

New details about the events at the show are being released all the time,

i:gl'aphy

18-21 MARCH 2017
THE NEC. BIRMINGHAM

SHOW
OPENING TIMES

Saturday, 18 March 2017
10:00-17:00
Sunday, 19 March 2017
10:00-17:00
Monday, 20 March 2017
10:00-17:00

Tuesday, 21 March 2017
10:00-17:00

www.photographyshow.com - 3



The Dragon’s €gg

+ +

Location: Moeraki Boulders, | Nikon D810 | Nikkor 14-24mm LEE Filters SW150 Mark |l Filter Holder,
South Island, New Zealand @ 14mm | ISO 100 | 1/14 | 10 seconds | 0.9 ND Hard Grad + Little Stopper

As | set up on the beach, the sky began to turn red. | looked for a simple composition, and found
it in the shape of this ‘dragon’s egg’, which | placed in the lower left third. To capture the slow,
receding movement of the sea, | would need a long exposure.

| used my Nikkor 14-24mm lens and LEE SW150 Mark |l filter holder with a 0.9ND hard grad to
help stop down the sky, which in this case was at least 4 stops brighter than my foreground. This
was then combined with a Little Stopper to increase my exposure time, giving me that soft minimal
long exposure look that | love.

Being able to use the SW150 system on my 14-24mm lens means | can now perfect my long-
exposure effects in camera, and only have to make minimal adjustments in postproduction.

Mark N filter system

Sarah Hatton
www.iso100.com.au

leefilters.com
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FREE TALKS saturday. 18 marer

15:00 - 15:30 insight into what drones can add
BEHIND THE LENS 15001530 ADOBE THEATRE  rsitinouiutd
Pros share tips and tricks,and photography Series of 30-minute sessions led
talk about their latest projects. Jenny Heyworth and by Adobe’s own creative experts
Catherine Connor on how to get the most from
11:00 - 11:40 Photoshop and Lightroom DRONE ZONE
Coastal visions 16:00 - 16:30 Seethe latestindrone
Karl Holtby Shooting the big day 10:15-10.45 kit and technology, flying
Greg Moment Combining Lightroom and demonstrations fromthe likes
12:00 - 12:40 Photoshop CC inyour of Yuneec, DJl and PowerVision,
Capturing the magic retouching workflow plusinstruction, inspiration
Bella Kotak and tips from top UAV training
11:00 - 11:30 provider Aerial Motion Pictures.
13:00 - 13:40 MUBI LE ﬁ SGBIAL Making your photos look
Expedition photography: Learnhowtouse socialmediato  amazing with Lightroom CC
Chasing swans from promote you rwuhrl-t -andhowto
blizzards to Blighty use your smartphone’s camera 11:45-12:15
Ben Cherry inacreative way. Using Lightroom Mobile u' HTUAI' HEALITY
inyour workflow E 360
15:00 - 15:40 12:00 - 12:30 Insight on VR and 360° from
Astrophotography for How to start and maintaina 12:30 -13:00 photographers suchas Nick
everyone successful YouTubechannel  Photoshop CC for Driftwood and Drew Gardner.
Steven Clarey Imogen Dyer and photographers Learn about new kit from Nikon,
Mark Wilkinson Ricohand more, see what
16:00 - 16:40 13:15 - 13:45 360" can bring to wedding
Getting more from 13:00-13:30 Starting out with LightroomCC ~ videography with Olympus
your camera The evolving power visionary John Nassari and learn
Angela Nicholson of photography and 14:00 - 14:30 about editing 360° images.
social media Contributing to Adobe Stock
Levanterman for photographers Check website for the
programme of talks.
14:00 - 14:30 14:45 - 15:15
I.WE STAGE Why you should create Fundamental imaging
Powered and presented ‘behind the scenes’ content techniques of post
by €pe=za for your work production
Demonstrations from leading Tommy Reynolds David Noton
photographers on how to shoot
awide range of subjects. 15:00 - 15:30 15:30 - 16:00
My Instagram adventures Mastering the basics
11:00 - 11:30 with Eric the stormtrooper of Lightroom CC Spaces at these
Creative styling and live Darryll Jones free talks are
lighting demo 16:15 - 16:45 limited, so if
Stoneimtonin S0, s RS
12:00 -12:30 social media 2;?1:& Seola
eat, get tothe
Master dance photography Xanthe Berkeley S G :
Andrew Appleton session early.
All of the stages
13:50 - 14:30 VIDED THEATRE and theatres
Outdoor Photographer Presented by Panasonic are around the
of the Year Catch talksincluding Nick edges of the hall
Presented by Outdoor Driftwood's Filming in 4K and (see the map on
Photography magazine 6K photo mode, Scouting, pages 24-25).

producing, shooting and editing
by Jonathan Edwards, plus

www.photographyshow.com - 5




PROPER ROADY PHOTO
COLLECTION

If photography is your passion you are constantly

on the lookout for the perfect moment, you want to
get everything right - the scene, your subject, your
camera, the right choice of lens and your camera bag.
With all this in mind, we have expanded the popular
Proper Roady collection with a range of camera bags.
All Proper Roady Photo bags were developed to carry
your loyal camera companion and accessories so that
you are at the ready to capture the perfect moment.

The collection is available in various sizes and three
different colours.

CRUMPLER.EU

Precision in the detail

Tripods | Monopods | Heads | Video Equipment
it pods | pods | | quip

Hall 5 - Stand C21 www.slrul.co.uk




FREE TALKS

BEHIND THE LENS

12:00 - 12:30
The freestyler: capturing

Pros share tips and tricks,and sports action and movement
talk about their latest projects.
13:00-13:30
11:00 - 11:40 The secret to relaxed
Big pictures, small cameras children's portraits
Ross Grieve Saraya Cortaville
12:00 - 12:40 15:00 - 15:30

Panel discussion: Making
aname in photography

L aura Pannack, Lottie
Davies, Natasha Caruana
and Anna Fox

13:00 - 13:40
Extraordinary images
of extraordinary people
Richard Bradbury and
Paul Wilkinson

14:00 - 14:40
Theart of long exposure
landscape photography
John Miskelly

15:00 -15:40

Turn on the light,

your passion is calling:
acreative's guide to
authenticity

Clare Louise

16:00 - 16:40
Telling stories and
making a difference
Luke Massey

LIVE STAGE

Powered and presented
by §ezo
Demonstrations from leading
photographers on how to shoot
awide range of subjects.

11:00 - 11:30
Multiple looks with
minimal kit

Tom Barnes

Five minutes in Photoshop
Angela Nicholson

16:00 - 16:30
Lightenup
Gavin Hoey

MOBILE & SOCIAL

Learn how to use social media to
promote your work - and howto
use your smartphone’s camera
inacreative way.

12:00-12:30
It's not allabout the numbers
Bert Stephani

13:00 - 13:30
Seeing differently:
alternative travel
photography
Martina Govindraj

14:00 - 14:30
My Instagram adventures
with Eric the stormtrooper
Darryll Jones

15:00 - 15:30
Modern social mediain
your business
Kevin Mullins

16:00 - 16:30

Visual storytelling through
iPhoneography

Sara Tasker

Psngtf:-.-graphy
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Sunday, 19 March

ADOBE THEATRE

Series of 30-minute sessions led
by Adobe's own creative experts
on how to get the most from
Photoshop and Lightroom

10:15-10.45

Combining Lightroom and
Photoshop CCinyour
retouching workflow

11:00 - 11:30
Making your photos look
amazing with Lightroom CC

11:45 - 12:15
Using Lightroom Mobile
in your workflow

12:30 - 13:00
Phatoshop CC for
photographers

13:15-13:45
Contributing to Adobe Stock
for photographers

14:00 - 14:30
Using Mobile apps to create
and publish your work

14:45 - 15:15
Fundamental imaging
technigues of post
production

David Noton

15:30 - 16:00
Mastering the basics
of Lightroom CC

16:15 - 16:45
Start out with Lightroom CC

VIDEO THEATRE

Fresented by Panasonic
Learn about subjects suchas
underwater filming, film making
with C5Cs, and making creative
short films.

DRONE ZONE

Seethe latestin drone

kit and technology, flying
demonstrations fromthe likes
of Yuneec, DJI and PowerVision,
plus instruction, inspiration
andtips from top UAV training
provider Aerial Motion Pictures.

VIRTUAL REALITY
& 360

Insight on VR and 360" from
photographers suchas Nick
Driftwood and Drew Gardner.
Learn about new kit from Nikon,
Ricohandmore, see what

360° canbring towedding
videography with Olympus
visionary John Nassari and leam
about editing 360° images.

Check website for the
programme of talks.

Many of our
exhibitors have
free talks and
demonstations
on their stands
too. Check on

our website, or
on the free app
(seep3) to get
the latest details
of everything
that's going on.

www.photographyshow.com - 7



AILTA ACTIOIN

ALTA RISE

AlLTA COLL ECTION

Inspired by feedback from photographers from around the world, the Alta Collection
reaches a new level of innovation and versatility. This stylish and function-rich collection of
tripods, camera bags and heads have solutions for all photography techniques.

ALTA RISE CAMERA BAGS
ALTA FLY

TROLLEYS ALTA SKY
ALTAPRO 2 PROFESSIONAL
TRIPODS CAMERA BAGS

ALTA ACTION TRIPOD BAGS

ALTA PRO 2 I ALTA SKY | ALTA FLY | ALTA RISE | ALTA AETION

@ VANGUARD  siuson

STAND H31

www.vanguardworld.co.uk
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FREE TALKS voncay. 20 marcr

13:00-13:30 shares his experience of working
BEHIND THE LENS The importance of the A[mBE THEATHE with directors, producers and
Pros share tips and tricks,and engagement shoot Series of 30-minute sessionsled ~ DoPs, and where video trends
talk about their latest projects. Brett Florens by Adobe’s own creative experts will go next
on how to get the most from
14:00 - 14:30 Photoshop and Lightroom
11:00 - 11:40 Live catwalk show
Landscape’s reward Jane Kelly 10:15-10.45
Charlie Waite Combining Lightroom and |] HU NE Zl] N E.
15:00 - 15:30 Photoshop CC inyour Seethe latestin drone
12:00 - 12:40 Shooting creative portraits retouching workflow kit and technology, flying
The Folklore Project: using colour gels demonstrations fromthe likes
recording Britain's stories Rossella Vanon 11:00 - 11:30 of Yuneec, DJl and PowerVision,
Hugh Hastings Using Mobile apps to create plusinstruction, inspiration
16:00 - 16:45 and publish your work and tips fromtop UAV training
13:00 - 13:40 Joe McNally lighting masterclass provider Aerial Motion Pictures.
The DIY photographer Joe McNally 11:45-12:15
Jason Parnell-Brookes Starting out with Lightroom CC

from N-Photo magazine

12:30-13:00

VIRTUAL REALITY

14:00 - 14:40 Photoshop CC for
Shoot more, edit less. MUBI LE & Sﬂﬂ”ﬂ. photographers & 36"
Ryan Welch Learn how to use social media to Insight on VR and 360" from
promote yourwork-andhowto  13:15-13:45 photographers suchas Nick
15:00 - 15:40 use your smartphone’s camera Using Lightroom Mobile Driftwood and Drew Gardner.
In conversation with Lisa inacreative way. inyour workflow Learnabout new kit from Nikon,
Barnard Ricohand more, see what
Lisa Barnard and 12:00 -12:30 14:00 - 14:30 360° can bring to wedding
Jean Wainwright Instagram: your platform, Mastering the basics videography with Olympus
your style, and your of Lightroom CC visionary John Nassari and learn
16:00 - 16:40 journey to pro about editing 360° images.
Bringing architecture to life Tobi ‘Tobishinobi’ 14:45 - 15:15
Tobi ‘Tobishinobi’ Shonibare Fundamental imaging Check website for the
Shonibare techniques of post programme of talks.
13:00-13:30 production
Beyond the lens: David Noton
embracing the future
with mobile photography 15:30 - 16:00
I.WE STAGE Mark Tipping Making your photos look
Powered and presented amazing with Lightroom CC
by $peza 14:00 - 14:30 Eating in
Demonstrations from leading How to build your 16:15 - 16:45 The Food
photographers on how to shoot Instagram profile Contributing to Adobe Stock Village will be
awide range of subjects. Zoe Timmers for Photographers open in Hall
11:00 - 11:30 15:00 - 15:30 etz
Creativity and safety in Modern social mediain the event.
newborn photography your business In addition,
Melanie East Kevin Mullins \” D Eﬂ TH EATHE numerous bars,
Presented by Panasonic restaurants and
12:00 - 12:30 16:00 - 16:30 Hear from Steven Clarey about seating areas
Theart of flattery Beyond thelens: embracing ~ mixingstills andvideo work, are situated
Stephen Perry the future with mobile and how taking to the air can around the NEC
photography improve your business from :
Mark Tipping Brent Kirkman. James Vellacott

www.photographyshow.com - 9
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FREE TALKS

Tuesday, 21 March

BEHIND THE LENS 1400 165 1L0D- 1130
Final: 60 SecondstoChange ~ UsingMobileappstocreate  [IRTUAL REALITY
Pros share tips and tricks, talk Your Life competition and publish your work
about their latest projects, and (winner announcement) E 36[]
debate hot topicsinphotography ~ Led by Training by Lumiere  11:45-12:15 Insight on VR and 360°
Starting out with photographers suchas Nick
11:00 - 11:40 15:00 - 15:30 Lightroom CC Driftwood and Drew Gardner.
Bringing architecture Photograph like a thief! Learn about new kit from Nikon,
tolife Glyn Dewis 12:30 - 13:00 Ricohand more, see what
Tobi ‘Tobishinobi’ Photoshop CC for 360° can bring to wedding
Shonibare 16:00 - 16:30 photographers videography with Olympus
Painting with light visionary John Nassari, and learn
12:00 - 12:40 Claire Harper 13:15-13:45 about editing 360° images.
Fashion, floods and circus Using Lightroom Mobile
Matilda Temperley inyour workflow Check website for the
programme of talks.
13:00 - 13:40 14:00 - 14:30
Forgotten locations MUBI LE ﬁ SﬂﬂlAL Mastering the basics
and hidden worlds Learn howtouse socialmediato  of Lightroom CC
Rebecca Bathory promote your work - and how to
use your smartphone's camera 14:45 - 15:15
14:00 - 14:40 inacreative way. Fundamental imaging
Close-up and macro techniques of post
photography 12:00 - 12:30 production
John Humphrey Using iPhoneography David Noton
as acreative tool
15:00 - 15:40 Philippa Stanton 15:30 - 16:00
You can shoot stock too Making your photos look
Dave Wall 14:00 - 14:30 amazing with Lightroom CC
Boost your business with
16:00 - 16:40 Facebook and Instagram 16:15 - 16:45
Unscripted moments: Jenny Johnston Contributing to Adobe Stock
discreet street photography for photographers
Matt Hart 15:00 - 15:30

Using iPhoneography
as acreative tool

Philippa Stanton u I n El] TH E ATRE
I.WE STAGE 16:00 - 16:30 Presented by Panasonic
Powered and presented Social mediaisn't perfect Speakersinclude music video
by €pmza Glashier maker Glashier and drone Eating out
Demonstrations from leading experts Aerial Motion Pictures. For those
photographers on how to shoot Learn about the transition from who stavinthe
awide range of subjects. stills to video with Steven Clarey o 31 :
area for a little
11:00 - 11:30 ADOBE THEATRE e ik
Directing your Series of 30-minute sessions led aselection o
portraits by Adobe’s own creative experts DHDNE ZUNE restaurants to
Rory Lewis on how to get the most from Seethe latestin drone choose fromin
Photoshop and Lightroom kit and technology, flying Resorts World.
13:00 - 13:30 demonstrations from the likes which s a five
Charity pictureraffle draw, 10:15- 10.45 of Yuneec, DJI and PowerVision, minute walk
see page 46. Combining Lightroom and plus instruction, inspiration ¢ Hall 5
Disabled Photographers’ Photoshop CCinyour andtips from top UAV training KIS
Society retouching workflow provider Aerial Motion Pictures.

10 - www.photographyshow.com
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SLING BACKPACK

THE OFFICIAL

LANYARD SPONSOR OF
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STAND C101

EXPLORE YOUR CITY WITH A VERSATILE CAMERA BAG THAT CAN KEEP UP WITH YOU.
PADDED YET STREAMLINED WITH STRAPS TO SUPPORT A TRIPOD AND A FULLY

CUSTOMISABLE INTERIOR. TAKE CONTROL AND ORGANISE YOUR EQUIPMENT.
ACCESS YOUR CAMERA THROUGH THE SIDE POCKET SO YOU NEVER MISS THAT
“DECISIVE MOMENT"”

PHOTO | VIDEO | STUDIO

To view our full range of products visit www.Phot-R.com

PhS$t-R 600

e ——— @PHOTRoOFFicial




SUPER STAGE

Albert Watson, Frans Lanting and David Alan Harvey head
the list of world-class photographers speaking on the
Super Stage at The Photography Show

Presented by zenfolio

Mick Jagger, Los Angeles 1992 @ Albert Watson




B Louis Cole

LOUIS COLE

broughttoyouby SONY

Best known for: daily video blogs
recounting his adventures
his adventures as

T

;

: ‘FunForLouis’, with
over 1.4 million Instagram followers
and 1.8 million subscribers to his
YouTube channel.

In this session, Louis will explore
the big part that photography plays
in building up a social media
community, describe his journey to

Louis Colehas a
huge social media
community around

becoming a social media influencer,

and give insight into how all of the
elements work together, as well as
why social media can be important
for photographers.

Saturday, 18 March 11:00 - 12:00

Tickets to see these living
legends of photography
cost £10 per session

(in addition to having

an entry ticket to The

Photography Show
itself). Guarantee your
seat by booking online at
photographyshow.com

4 4 ’ -

Kate Moss, Marrakesh, 1993 © Albert Watson

ALBERT WATSON

Best known for: creating some
of the photo world’s most
well-known, iconic images

Born blind inone
eye, 74-year-old

Scottish shooter
B \ﬂ' Albert Watsonis

“ world famous for
his art, fashion, landscape and
commercial photography, producing
100 Voguecovers and 40 covers for
Rolling Stone, including aniconic
double exposure portrait of Mick
Jagger and a leopard for the 25th
anniversary edition of the magazine
(pictured opposite).

This is a rare chance to listen to
one of the most prolific, versatile
and sought-after photographers
of our time as he looks back on a
lifetime of producing the clean and
graphic images that have made him
into amodern-day icon. Albert's
extraordinary ability to apply his craft
to every genre is truly inspiring.

His most celebrated images -
of Alfred Hitchcock holding a dead
goose, a teenage Kate Moss (shown
above), Michael Jackson, Steve Jobs
andmore - are sure todraw inthe
crowds and make this a once-in-a-
lifetime experience.

Saturday, 18 March 13:00 - 14:00
Sunday, 19 March 11:00 - 12:00

18-21 MARCH 2017
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Grenada. 1979 & Alex Webb/ Magnum Pholos

ALEX WEBB
brought to you by

Best known for: popularising
colour street photography

Photojournalist Alex
Webb uses strong
colours, light and
emotion to capture
the beautifully
compleximages. His work could sit
next to Henri Cartier-Bresson’s ‘The
Decisive Moment' in the dictionary.

Although the Magnum Photos
photographer is best known for his
emotive, colourful images that allow
aglimpse of Latin America's chaotic
street life - including in Cuba, Haiti,
Mexico — he was first inspired by
Cartier-Bresson, and started out
shooting in black and white.

Agedonly 24, and still shooting
only in mono, he became a Magnum
nominee. That was in 1976, and he
became a full member of the famous
agency only three years later. His
move over to shooting in colour and
subsequent work has inspired a new
generation of colour-shooting
documentary photographers.

In his 40-year career, Alex has
published seven photography books
so far, and still continues to be one of
the most respected photojournalists
of our time.

Saturday, 18 March 15:00 - 16:00

www.photographyshow.com -
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Leonard Cohen & Jill Furmanavshy rockarchive.com

JILL FURMANOVSKY

Best known for: being the queen
of rock 'n’ roll photography

In the mid 60s, Jill
- Furmanovsky landed
in London, relocating
with her parents from
' Zimbabwe. [t was a
move that shaped the rest of the rock
photographer’s life: at 11, Jill became
amember of the Beatles fan club.
Her first rock shot was on a Kodak
Instamatic, of Paul McCartney
standing outside his house.

In1972, after only two weeks
training in photography at the
Central School of Art and Design,
Jillmarched her way into the press
pit at a Yes concert, with a borrowed
camera inhand. The move earned
her a place as the official (unpaid)
photographer at a premier London
rock venue, The Rainbow Theatre.

Jillhas gone on to become an
iconic rock photographer who we
celebrate today, and the founder of
Rockarchive, capturing the biggest
names in the industry: Led Zeppelin,
Bob Marley, Pink Floyd, Bob Dylan,
The Police, Oasis and many more.
Hear one of the world’s leading rock
photographers lift the lid on a lifetime
at the forefront of rock and roll.

Sunday, 19 March 13:00 - 14:00

- www.photographyshow.com

Orang-utan & Frans Lanting.lanting.com

FRANS LANTING

Best known for: setting the
standard for modern wildlife

photography

Over four decades,
Frans Lanting has
worked closely with
the World Wildlife

. Fund, been published
in National Geographic and Lifeand
influenced the industry and the world.

Frans has proved that wildlife

photography is not just about
executing sharply focused animal
portraits with plenty of bokeh. He
looks at shooting his wild subjects

as acanvas just waiting to be painted.

He understands that to fully connect
with the subject, we need to find new
ways of describing the ‘essence’ of
them. He has rewritten the laws that
defined the prevalent style of the day,
and much of what we have seen since
reflects his influence in the field of
wildlife photography.

Don't miss the chance to hear this
activist with a camera and pioneer in
the field of wildlife photography. This
talk is based around Frans's recent
‘Dialogues with Nature’ exhibition,
amajor retrospective showcasing
images from five of his signature
projects produced over 40 years.

Sunday, 19 March 15:00 - 16:00
Monday, 20 March 11:00 -12:00

David Bowie £ Clive Arrowsmith

CLIVE ARROWSMITH

Best known for: his celebrated
shots of stars and celebrities
from the 1970s onwartds

Clive Arrowsmith’s
body of work is
extensive - spanning
the genres of fashion,
advertising, music
and celebrity portraits, from Paul
McCartney to Prince Charles, and
De Beers to Yves Saint Laurent.

Clive will describe the path he
takes to produce images that draw
in the viewer; how he subtly directs
portrait subjects and choreographs
his models on fashion shoots,
accounting for every detail.

This talk will be fast-paced and
fun, with many behind the scenes
tales of his celebrity adventures.

Monday, 20 March 13:00 - 14:00

The Super Stage offers
you a unique opportunity
to hear some of the best-
known photographers

on the planet. Tickets
sell out quickly, so we
strongly advise you

to book in advance to
avoid disappointment.



Barack Obama lil, 2012 & Madav K.ander

NADAV KANDER

(in discussion with William A Ewing)

Best known for: iconic portraits of
Barack Obama and Donald Trump

Multi-award winning
photographer
Nadav Kander is

the man who shot
Donald Trump! The
much-discussed limemagazine
cover of 2016 was the latest in
Nadav's impressive portfolio of
portraiture featuring world-famous
names from Barack Obama to Prince
Charles. But Nadav is as well known
for his landscapes as he is for his
portraits, and has won numerous
accolades for both = including a Prix
Pictet for his landscapes on the
Yangtze River and a World Press
Photo award.

He made headlines with his
portrait series ‘Obama’s People’,
commissioned by The New York
Times Magazine to coincide with
President Obama's inauguration in
20089. Kander's 52 portraits made
up the largest single photo story that
the veteran publication has ever
published in a single issue.

This interview, led by curator Bill
Ewing, offers visitors an opportunity
to get insight into Nadav's unique
career and approach.

Monday, 20 March 15:00 - 16:00

Cuba, 1998 € Dawvid Alan Harvey/Magnum Photos

DAVID ALAN HARVEY
brought to you by

Best known for: his documentary
images for National Geographic

One of the most
well-respected
photojournalists
of our time, and
now a Magnum
Photos great, David Alan Harvey
was an early adopter of photography.
Aged1l, he bought a Leica with his
newspaper round savings and began
shooting photographs of his family
and his neighbours. That was in 1956.

In 1967, he published his first book
Tell it like it is, documenting the lives
of a black family living in Virginia. He
went on to shoot 40 photo essays for
National Geographic, covering social
and culturalissues across the globe
and varied subjects including the
Berlin Wall, native Americans and
French teenagers.

David joined the Magnum photo
agency as a full-time member in
1997 and launched the award-
winning Burnmagazine in 2008,
which showcases emerging new
talented photographers.

Don't miss this chance to hear
the thoughts and insights of a true
photography heroin this talk, entitled
‘Shoot what it feels like'.

Tuesday, 21 March 13:00 - 14:00

18-21 MARCH 2017
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Sujit Kumar (The Chicken Boy), Fiji . 2005 ® Julia Fullerton-Batten

JULIA FULLERTON-BATTEN

Best known for: her provocative
photo essays on the growing pains
of teenage girls

Anacclaimed fine art
photographer, Julia
Fullerton-Batten
started her photo
careerin 2001 and
rapidly developed her reputation

as one of Europe’s leading young
photographers. Julia's use of unusual
locations, highly creative settings
and street-cast models, accented
with cinematic lighting, are hallmarks
of her very distinctive and enthralling
style of photography.

The foundation of her success
was her 2005 project ‘Teenage
Stories’ - an evocative narrative
of the tough transition of ateenage
girlinto womanhood. This and her
sequel projects portray the difficult
stages and life situations of female
adolescence. Juliaadmitstoa
pronounced semi-autobiographical
influence in much of her earlier work,
often falling back onrecollections of
her own early and teenage years.

Onthe Super Stage, Julia will
delve further into her latest two
projects — 2015's 'Feral Children’ and
2016's ‘'The Act’ — exploring their
controversial subject matter.

Tuesday, 21 March 15:00 - 16:00

www.photographyshow.com -



MASTER
GLASSES

As well as the many free features
and talks available at the show,
we have several masterclasses
suited to all levels that are well
worth signing up for...

16 - www.photographyshow.com

BEGINNER'S MASTERCLASS

Saturday, 18 March and Sunday,
19 March, Toute Suite £10

Start your photography journey by learning some essential
lessons from the experts. There's a charge of £10 for this
four-part programme, in addition to the show entry fee;
choose Saturday or Sunday morning. The Toute Suiteis
located just outside Hall 5 (see map on p19).

10:30 - 11:05

Choosing the right camera

A look at what camera is best for you, including a run down
of the key features and what you do and don't need
Angela Nicholson

11:05 - 11:40

Choosing a lens

Learn the basics of choosing a lens to suit you, including
what different focal lengths and apertures are for
Damian McGillicuddy

11:50 - 12:25

Getting to grips with imaging software

A starter session onimaging software, to help you to
understand the basic tools and more advanced techniques
Amy Watkins

12:25 - 13:00

Troubleshooting your photography:
common problems and how to solve them
Key elements of focus and exposure explored
Nina Bailey
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TURNING PRO MASTERCLASS

Saturday, 18 March and Sunday,
19 March, Toute Suite £10

Looking to make the jump from enthusiast to professional?
This half-day masterclass will help you to understand the
benefits of going pro and what to watch out for, There's a
small charge of £10 for this afternoon programme, which is
held in the Toute Suite located just outside Hall 5 (see p19).

14:00 -14:35

Making the transition from enthusiast to pro
The first steps of setting yourself up as a pro, and how
to market yourself and your work to attract clients
Amit and Naroop

STUDENT CONFERENCE

Tuesday, 21 March, Toute Suite £5

Students get in free to The Photography Show onthe
Tuesday... but why not make even more of your trip by
signing up for the afternoon series of inspirational talks
tailored specifically for students? There's asmall charge
of £5 for this packed Tuesday afternoon programme.

13:30 - 14:10

Student to pro - life in the photography business
Kate discusses her experience of building a successful
photography business, plus top tips for starting as apro
Kate Hopewell-Smith

14:35-15:10

Software - the ultimate camera accessory

How to choose the right software for your business,
including what features are available and what you need
David Grover

15:15 - 15:50

How to market yourself effectively on social media
Dos and don'ts for marketing yourself as a photographer
on social media, and the nuts and bolts of SEO

Charlie Giles

15:50 - 16:20

How a drone could improve your business

How using drones could increase your client base, add
value and drive profit to your business

Matt Williams

16:20 - 16:45

Tips for your first year as a pro

Three professional photographers discuss how they
survived and thrived through their first year in business
Bella Kotak, Rory Lewis, John Nassari

14:30 - 15:10

The right direction:

Running your shoot and working with a team

A practical demonstration of a studio photoshoot, run
by experienced professionals, showing you how to work
effectively as a team and giving you useful advice
Monica Montalvo, Stephanie Thornton and

Steve Howdle

15:30 - 16:10

Panel discussion: Turning daydreams into dayjobs
Offering insight into why they do what they do, our
panel of professionals give insight into their first years

in business, sharing their challenges and successes
Ryan Welch, Jacob McCarthy, Matilda Temperley,
Tom Mason and Nicole Gomes

16:15 - 16:30

CLOSING KEYNOTE: David Alan Harvey

Acclaimed Magnum photojournalist David Alan Harvey
gives an insight into his long career working for Mational
Geographic and other leading publications

David Alan Harvey

www.photographyshow.com - 17



Working photographers have a
special place at The Photography
Show — and this year there is even
more going on just for pros — over

all four days of the event
Pro entry to the show is free, subject to validation

VISIT THE
\EBSITE AND FILTER
THE PROGRAMMES

BY ‘PROLEVEL T0
SEE WHAT'S ON
FOR PROS

+ www.photographyshow.com

PRO LOUNGE

Come along tothe Pro Networking Lounge where you cangraba
drink, catch up with colleagues and exchange ideas with like-minded
industry professionals ina tranquil environment.

PRO HAPPY HOURS

Our pro Happy Hours will give you the chance to relax after a big day
at the show between 16:00 and 17:00 on Saturday and Sunday.

PRO LOUNGE LIVE

A series of sessions taking place at the weekend will focus on some of
the more specific challenges faced by professional photographers.

PRO DRINKS RECEPTION

Don’t miss our professionals drinks reception on Monday evening,
featuring amusing anecdotes and advice from speakers.

ENHANCE YOUR SKILLS

The Behind the Lens Theatre and Live Stage return, featuring
tutorials and practical demos that focus on arange of genres and
techniques, plus debates tailored tothe pro. Qur panel discussionon
making a name for yourself in photography is sure to interest.

EXPAND YOUR SERVICES

Discover all of the skills you need to capture dynamic footage on
camera and to integrate moving images into what you offer your
clientsin the Video Theatre and Drone Zone.

DISCOVER NEW TECHNOLOGY

Our brand new 360 & Virtual Reality Stage will showcase the most
talked about technology out there and reveal how it can be usedin
a professional sense now, and in the future,

PRO CONFERENCE

In-depthbusiness advice, from pricing your photography and valuing
yourself, towaysin which you canattract new clients. See the listings
opposite for a breakdown of the sessions onoffer.



PRO
CONFERENGE

A conference offering in-depth
commercial advice and creative

ideas to drive your business forward.

Book one of the morning sessions
for £10, or sign up for both for £15

Monday, 20 March, Toute Suite

10:15-10:30
OPENING KEYNOTE: Clive Arrowsmith
Clive Arrowsmith

10:30 - 11:05

Marketing and finding new business

How to find the right market, research leads and make sure
that you stand out from the crowd

Hat Margolies

The
Phot.graphy
ShOW &2t b

Tuesday, 21 March, Toute Suite

10:30 - 11:05

Personal projects attract new clients

Why keeping your creativity alive isimportant to attract
new business, and tips on finding compelling ideas
Tom Oldham

11:05 - 11:40

Pricing your photography and valuing yourself
What are you and your work worth? Working to a day rate
vs working to a budget explored

11:05 - 11:40

Creating movie-style drama and storytelling in stills
Stand out from the crowd, create atmospheric images and
tell stories with camera angles and composition

Nick Dunmur Glashier
11:50 - 12:25 11:50 - 12:25
When calamity strikes Become an editorial superstar

Flan for unexpected events and ensure that you have the
right insurance cover for your business
Clare Sugden

How to pitch ideas to magazines and newspapers and
become a successful editorial photographer
Matthew Fearn

12:25 -13:00

What you need to know BEFORE you fly your drone
Discover the regulations you need to follow and how to get
licensed to use your drone for photography

Matt Williams

The Photography Show is held in the largest of the National

Exhibition Centre’s halls - the 25,000m¢ Hall 5. However, our
Masterclasses and Conferences are all held in the Toute Suite
which is found in the Piazza entrance area just outside Hall 5.

12:25-13:00

A new angle on sports photography

How to use robotic cameras to get your camerain places
humans can't go, to take unique sports shots

Bob Martin

www.photographyshow.com - 19
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MY CLOUD™ EX2 ULTRA | MY CLOUD™ EX4100 MY PASSPORT™ WIRELESS PRO

PRE-CONFIGURED NAS WI-FI* MOBILE STORAGE
« Centralise your media in one safe, organized place « Wireless 802.11ac for fast data
transfers
« Pre-populated with ultra-reliable wD Red™ NAS hard
drives « SD 3.0 card reader for fast media
offloads

« Protect your media with multiple backup and RAID
+ All-day battery (up to 10 hours)*

options
and USB power bank to charge
« My Cloud mobile app and MyCloud.com web access mobile devices
« USB 3.0 for super-fast media
The transfers;
I I |°t{}g aphy USB 2.0 port to import
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See WD at stand G33 for exclusive show offers only. Actual battery W depends on ~fle sios,
For more product information visit us at wde.com connectivity, settings and other factors.
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STAND-BY-STAND GUIDE TO OVER 230 EXHIBITORS..

1901 FOTOGRAFI A
www.1901fotografi.co.uk
Beautifully simple, hand-made

leather camera straps and fotobags.

1CLICKPRINT B
www.lclickprint.com

Specialists in creating quality photo
canvases, acrylic prints and other
photo finishing services.

ABRAHAM ALBUMS A
www.abrahamalbums.co.uk

Bespoke professional photo albums
that offer high-quality, fast delivery
and competitiive pricing.

ADAPTALUX A
www.adaptalux.com

Innovative miniature lighting studio
that's ideal for macro photography.

3 LEGGED THING E
www.3leggedthing.com

Not just another tripod, but a
culmination of smart British
design and craftsmanship.

AADUKI MULTIMEDIA
INSURANCE J
www.aaduki.com

Leading insurance providers for
photographers and video makers,
from amateur to fulltime pros.

ADOBE
www.adobe.com/uk
Get the most from Adobe Photoshop
and Lightroom with our series of
seminars on digital image editing
and manipulation (see pages 5-10).

ADOBE THEATRE

AERIAL MOTION c
PICTURES
www.aerialmotionpictures.co.uk
Drone specialists witha CAA-
approved independent training
school and rental facility.

AFFINITY c
www.affinity.serif.com

Developers of Affinity Photo image
editing program, which is available
for Windows, as well as for Mac.

AJ'S G
www.aj-s.co.uk

Providers of professional lighting and
other studio equipment.

ADVANCED CAMERA
SERVICES
www.advancedcameraservices.co.uk
Camnera-repair specialists renowned
for infra-red sensor conversions.

ALBUMPROFISSIONAL J
www.albumprofissional.com
Portuguese photobook and album
specialists offering a wide range of
different products.

www.photographyshow.com - 21



IR FOR WHEN YOU NEED
=1y REAL PROTECTION!

Specialist suppliers of
heavy-duty, protective
hard cases, travel cases
and flight cases.

- IP Rated

- Practically indestructible
- Guaranteed for life!

- Specialist drone cases

- Bespoke design service
- EXCLUSIVE show offers

WWW.panzZercases.co.u K

Find us at

STAND
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AMATEUR PHOTOGRAPHER F
www.amateurphotographer.co.uk
The world’s longest-running weekly
photographic magazine.

APERTURE BOOKS H
www.aperturebooks.com
Hand-crafted photo books for the
professional photographer.

APPLETON PHOTO J
TRAINING
www.appletonphototraining.com
Learn to take better pictures with
Andrew Appleton in groups, on your
own, at home and abroad.

BENQ c
www.beng.co.uk

Colour-critical line of monitors,
designed for photographers and
creative designers.

BENRO E
www.benroeu.com

Making a high-quality range of
tripods and heads to suit most
photography genres.

BESSEL A
www.bessel.co.uk

Independent supplier of high-quality
studio lighting equipment.

ARCOALBUM H BIG CROCODILE J
www.arcoalbum.com www.bigcrocphotoprops.co.uk
Handmade photography albums, Luxurious, handmade props
books and more from Lithuania. for baby photography.
ASSOCIATION OF G BILLINGHAM G
PHOTOGRAPHERS www.billingham.co.uk
www.the-aop.org Classic camera bags, made

Protects and represents the best
of professional photographers.

ATOMOS D
www.atomos.com

Offers cutting-edge products for
video pros that merge key editing
features into a touchscreen device.

B+W E
www.bpluswfilters.co.uk

Quality screw-in photography filters
—including 10-stop NDs, variable
NDs, polarisers and UVs.

BABY PROP SHOP A

www.babypropshop.co.uk
Retailers of high-quality baby

photography props and accessories.

BARBER SHOP B
www.barbershopbags.com
Collection of bags and accessories
designed and made in Italy.

BEAUTY GATE J
www.begate.co.uk

Offering relaxing shiatsu
massage equipment.

BENEL BV B
www.benel.eu

Importer and wholesaler of photo
studio equipment offering 3500
iterns worldwide.

BOOKED IMAGES B
www.bookedimages.com

Exquisitely tailored books, with every
little detail done by hand in the UK.

BOOTH EXPERIENCE A
www.boothexperience.co.uk
Suppliers of photobooths and selfie
mirrors for events.

BOOTH REVOLUTION A
www.boothrevolution.com

Deluxe photobooths for weddings,
parties and corporate events.

BOUNCELITE H
www.bouncelite.com

Change the way you use flash with
the accessory that diffuses and
controls your flashgun.

BOWENS E
www.bowens.co.uk

Studio and location lighting, as well
as creative light-shaping tools for

in England since 1973. professional image makers.
BLACK+WHITE J BRINNO A
PHOTOGRAPHY www.brinnouk.com
www.thegmcegroup.com Specialists in high-definition
The monthly monochrome time-lapse cameras.
magazine published by GMC.

BRITISH INSTITUTE F
BOB RIGBY C OF PROFESSIONAL
PHOTOGRAPHIC PHOTOGRAPHY
www.bobrigby.com www.bipp.com

Distributors of Wimberley gimbal
heads, Plamps, Acratech ballheads,
and the Rigby ProClamp.

Internationally-recognised qualifying
organisation, which has supported
photographers for over acentury.

CRASH-FREE DRONES

Quadcopters get smarter

Smart object avoidance, vision sensors and automatic flight

controls are transforming drone photography so that even novices

can take to the skies safely. Visit the Drone

Zone tosee the latest modelsin
action. Professionals take note -
you can now get flying lessons
for your aerial companion, and
if youre shooting drone video
commercially you'll also

need official certification.

-
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' CAPTURE THE MOMENT FOR LESS

Kenro SPEEDFLASH

''' The new Kenro Speedflash is compatible with both Nikon iTTL and Canon
el TL systems and is packed with all of the features you need.

O OW™ . =
\ " #These include; high speed synchronisation, —
p *. Sfand S2 slave functions, fast recycle time, /s
manual or auto zoom, built in diffuser, \
backlit LCD screen and a high power output r

- of GN58 at ISO100.

The KFL101 also comes with a carry case,
soft box and flash stand and retails at less
than £100, making it great value for money.

Visit www. kenro.co.uk for more information. .

Supplying the photographic industry for over 40 years » www.kenro.co.uk 4@
M Kenro Ltd, Greenbridge Road, Swindon, SN3 3LH £ Follow us on Twitter YEARS OF
t: 01792 615836 £: 01793 530108 e: sales@kenro.co.uk Kl Like us on Facebook Kenro

LensesForHire .co.uk

Affordable hire prices

Huge range and huge stocks

Helpful advice from friendly
and knowledgeable staff

oecure online ordering

Comprehensive worldwide insurance
included as standard

e ————— e ——— =S s ——

www.LensesForHire.co.uk ......... help@LensesForHire.co.uk
080061 27261 ......... 01628 639941




18-21 MARCH 2017

Pgot wgraphy

THE MEC, BIRMIMGHAM

BRONCOLOR F
www.ukbroncolor.com

Swiss studio lighting manufacturer
showing off its range of monobloc
flash heads and power packs.

CNP SAFARIS G
www.cnpsafaris.com
Photograph birds and animals in
top nature reserves in Namibia,
Botswana, Kenya and beyond.

CAKE SMASH PROPS J
www.cakesmashprops.co.uk
Specialists in fun maternity and baby
props for portraits with adifference.

CALUMET C
www.calphoto.co.uk

Supplying professional and budding
photographers with equipment and
advice for over 70 years.

CAMERAWORLD D
www.cameraworld.co.uk

Offering not only the best show deals
but the best in customer service.

CANON UK D E
www.canon.co.uk

Try award-winning DSLRs and pro
video cameras, or print images with
PIXMA and large-format printers.

COLEG GWENT K
www.coleggwent.ac.uk

Training courses for professional
photographers - enter the prize
draw at the show towin a free place!

COSTCO WHOLESALE K
www.costco.co.uk

Membership Warehouse Club offers
goods and services at low prices.

CREATIVE K
PHOTOGRAPHY WALES
www.creativephotographywales.com
Offers expert tuition in landscape
and outdoor photography, from
beginner to pro levels.

COLOR CONFIDENCE c
www.colorconfidence.com
Europe’s leading colour
management specialist for

the digital imaging market.

COLORAMA E

www.colorama-photo.com

Varied, high-quality backgrounds

for the professional photographer.

COLORWORLD IMAGING F
www.colorworldimaging.co.uk
Professional photographic printing,
known for high quality and value.

CANSON G
www.canson-infinity.com

Offers an extensive range of inkjet
papers and canvases, with stellar

COMPAGNON A
www.compagnon-bags.com/en
Handcrafted camera bags and photo
backpacks made from natural

printing performance. materials such as waxed canvas.
CANVASBAY K CONTOUR DESIGN A
www.canvasbay.co.uk www.contourdesign.com/us

One of the largest manufacturers
of photo canvases in the UK.

CATS PROTECTION K
www.cats.org.uk

National feline welfare charity.
CBL DISTRIBUTION K
www.cbldistributionltd.co.uk

Books to suit all enthusiasts, whether
you are a beginner or a professional.

CEWE H
www.cewe-photoworld.com
Transformyour best images into
beautifully-bound photo books,
prints or wall art.

CLICK PROPS B
www.clickprops.co.uk

Creative backgrounds and newborn
art props for more interesting
images and bigger sales.

Ergonomically designed products to
boost photo and video creativity.

CREATIVITY A
BACKGROUNDS
www.creativitybackgrounds.co.uk
Suppliers of high-quality
photography studio backdrops,
backgrounds and flooring.

CRUMPLER C
www.crumpler.eu

Functional, design-focused
backpacks and shoulder bags with
lots to offer the keen photographer.

DEWI LEWIS H
www.dewilewis.com

Book publisher with titles by leading
photographers. Signed copies
available to buy.

DIGITAL CAMERA F
MAGAZINE
www.facebook.com/digitalcameraworld
The definitive guide to DSLR and
CSC photography. Digital Camera

is the UK's best-selling photography
magazine, by Future Publishing.

SUPERSIZE MY SENSOR

Medium format cameras reinvented

See and touch the new generation of

super-quality mirrorless cameras from
Hasselblad and Fuijifilm. With sensors twice
the size of regular full-frame, they promise
a big step forward inimage quality but with
cameras much more weildy and portable
than traditional medium-format monsters.
They're pricey for amateurs but could

offer pros that vital competitive edge.

www.photographyshow.com -
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DIGITAL PHOTO A
SOLUTIONS

www.dpsb.co.uk

Find show offers on printers, tablets

and colour management equipment,

plus Datacolor's Digital Imaging
Training Theatre.

DIGITAL PHOTOGRAPHER F
www.dphotographer.co.uk
Exceptionalimages, expert advice
and all the latest technology
explained in this monthly magazine.

DIRECT SOURCE H
www.direct-source.com
UK’s largest supplier of blank media

discs and packaging for media work.

DISABLED H
PHOTOGRAPHERS' SOCIETY
www.the-dps.co.uk

Charity promoting photography for
people with disabilities and their
carers, it's having a secondhand kit
sale and will be taking donations.

DJI F
www.dji.com

Leading maker of camera drones
and quadcopters for aerial imaging.

DORR FOTO A
www.dorrfoto.co.uk

Extensive range of accessories
and optical goods, from scopes
to studio equipment.

DREAMBOOKSPRO J
www.dreambookspro.com
Producer of high-quality photo
albums and accessories.

DROBO G
www.drobo.com

Data storage experts known for their

self-managing NAS and RAID drives.

DS COLOUR LABS H

EASYCOVER B
WWW.easycover.eu

Protective armour for your camera,
lenses and LCD screen.

EIZO G
www.eizo.co.uk

Makers of high-quality monitors,
including the EIZ0 ColorEdge.
ELINCHROM D
www.elinchrom.com

Producers of the world's most
portable studio flash since 1962.

EOS MAGAZINE F
WWW.e0s-magazine.com

Take your Canon photography to
anew level with EOS magazine.

EVERSURE INSURANCE A
www.eversure.com/camera
Insurance for amateurs, semi-
professional and pro photographers
orvideographers.

EXPOIMAGING C
www.expoimaging.com
Manufacturers of the Rogue
Flashbender and its family of flash
accessories, and makers of the
ExpoDisc white balance filter.

FIG BAGS B
www.fighags.co.uk

Handcrafted in England, Fig Bags
provide vintage styling and practical
solutions for carrying your camera
kit, using premium leather.

EOS TRAINING F
ACADEMY
www.eostrainingacademy.co.uk
Specialists in dedicated Canon

FJALLRAVEN J
www.fjallraven.co.uk

Swedish clothing designed for
the outdoor adventurer, to help

photography tuition. you shoot whatever the weather.
EPSON E FLAGHEAD G
www.epson.co.uk www.flaghead.co.uk

Makers of awide range of products,

from A4 printers to large-format
output on 64 inch-wide rolls, and
from scanners to projectors.

ETERNA MEDIA K
www.eternamedia.co.uk

The UK's largest manufactuer

of canvas stretcher bars.

Distributor for pro photographic
equipment brands including Hedler,
TriggerSmart, Honl and Quantum.

FLORICOLOR UK B
www.floricoloruk.com

A wide range of professional wedding
photo albums and high-end
photobooks from Porto, Portugal.

INSTANT GRATIFICATION

Stepping back to the days of film

Darkroomis not dead... and instant

cameras are cool with the kids.

Lomography will be showing off its retro-
themed analog cameras and lenses, and
check out the mini-resurgence in instant
imaging too. Shooting with your phone
is 50 passé at parties - with an instant
camera you get a physical print right on
the spot as a momento.

www.dscolourlabs.co.uk
Leading professional photo labs, with
unbeatable prices and service.

Dx0 F
www.dxo.com

Advanced and powerfulimage
processing software, aswell as the
innovative Dx0O One camera that
connects to your mobile.

www.photographyshow.com
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IDEAL FOR PORTRAIT / MACRO PHOTOGRAPHY & VIDEO = UNIVERSAL HOT SHOE MOUNT, OR 1/4" 20 LIGHTING STAND
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FOCAL POINT IMAGING C
www.focalpointimaging.co.uk

Dealers in photographic and fine art
print solutions including large-format

GITZO E
www.gitzo.co.uk

Italian maker of luxury professional
tripods, heads and monopods,

HASSELBLAD F
www.hasselblad.com

Makers of high-quality, reliable
medium-format digital cameras

printers and colour calibration tools. lusted over for 90 years. and scanners.
FOOLOGRAPHY c GLOBAL DISTRIBUTION D HAWKESMILL ENGLAND K
www.foolography.com www.globaldistribution.com www.hawkesmill.com

Smart solutions for controlling your
cameradirectly fromyour phone, or
adding GPS to your SLR.

FORMAT FESTIVAL B
www.formatfestival.com

Annual photo festival in Derby, held
this year from March 24 - April 23.

FOTOLAND IMAGING J
& EVENTS

www.fotolandimaging.com
Offering safari tours to Tanzania.
FOTO MASTER G
www.fotomaster.co.uk

Photobooths with a difference,
including the Mirror Me Booth and
the Digital Grafitti Wall.

FOTOSPEED G
www.fotospeed.com

Market leader in darkroom supplies,
digital inkjet paper, and more.

Leading technology for end-to-end
solutions for 4K and HD workflows.

Luxurious camera bags and straps,
handmade in England by craftsmen.

GOT PHOTO A
www.gotphoto.co.uk

Anonline shop system for nursery
and school photographers.

GUIDE DOGS J
www.guidedogs.org.uk

Sponsor a guide puppy and follow
every step of their amazing journey.

HAHNEMUHLE J
www.hahnemuehle.com
Germany's oldest paper makers,
supplying papers for traditional
and digital artists.

HHJ TRADING H
www.hhj-trading.co.uk

UK makers of an extensive range
of photo frames, including
multi-aperture frames.

HPRC B
www.hpre.it/en

Cases used worldwide by pros to
protect and carry arange of gear.

HUNGRY EYE H
www.lifemediagroup.co.uk
Quarterly journal dedicated to
filmmaking and photography.

HAIDA PHOTO A
www.haidaphoto.com/en
Anewname infilters, Haida make
ND, polariser, infra-red and other
special effects filters.

INDURO E
www.indurogear.com

Tripods and heads designed inthe
USA, designed with input from
professional photographers.

FREEDOM EDITS F
www.freedomedits.com

Outsource your photo editing or
album design and have more time
for the rest of your photo business.

FRITH & CO J
www.frithandcompany.co.uk
Establishedin 1973, thisis a
family-run specialist in frame
making and mount cutting.

FUJIFILM D
www.fujifilm.eu/uk

Japan's pioneering photographic film
maker is a global presence known for
innovation in digital photography.

GFSMITH A
www.gfsmithphotographic.com
Designer and maker of beautiful
photobooks, frames and mounts.

GILLIS LONDON G
www.camerabags.gillislondon.com
Quality leather bags and wallets
for stylish photography.

www.photographyshow.com

HALSYS B
www.halsys.co.uk

Reliable digital imaging and database
workflow systems for pro fessional
photographers and laboratories.

INFOCUS PHOTOGRAPHY J
INSURANCE
www.infocusinsurance.co.uk
Comprehensive insurance
protection at affordable premiums.

360-DEGREE VISION

Giving an immersive experience

Discover the stunning new world of
affordable 4K 360° video - it will change
the way you see, shoot and edit your
footage. You can let viewers choose what
they want to watch by panning around a
360° scene, or use that all-round footage
to create regular video with smooth
panning effects that follow even the most

unpredictable action.




The ultimate folio box for your
reveal wall.

2 KATE HOPEWELL-SMITH =

Get a 14x| | Studio Sample for just £82 delivered.
For more information, visit 3xmsolution.com/ | 4x| |
or come see us at stand Bl | [.
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LEARN NEW
SLR SKILLS!

Allthe best bits from [ and
in two brilliant 228-page handbooks

2 GREAT WAYS TO LEARN! : TO LEARN! P4
READ OUR GUIDES « WATCH THE VIDECS faf=1a3) READ OUR GUIDES - WATCH THE VIDEOS | FREE

DISC DISC
=8N Canon ==
'Photographer’s’|  Photographer’s

Handbook Handbook
228
PAGES

TOLEARN! PLUS!

| |Canon _
Photographer’s Photograq'tlngbr;sk

® Master your \ Handbook
Nikon camera

@ DSLR advice

@ Gear tests

® Photo projects

@ Pro techniques
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Phesta progets
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Onsale now at newsagents, Apple Newsstand & Zinio

For more brilliant handbooks visit
www.myfavouritemagazines.co.uk/photo
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INNOVA ART A B
www.innovaart.com

UK-based maker of premium inkjet
media and image display products.

INTELLECTUAL K
PROPERTY OFFICE
www.ipo.gov.uk

UK government body responsible
for trade marks and copyright.

KODAK EKTRA c
www.bullitt-group.com

Come to see the Kodak smartphone
that has been designed for
enthusiast and pro photographers.

LENSBABY H
www.lenshaby.com

Makers of award-winning,
creative-effects lenses for SLRs,
CSCs, mobiles and more.

KODAK PIXPRO E
www.kodakpixpro.com
See the Kodak actioncam range

including the new 4K 360° VR PixPro.

LENSES FOR HIRE B
www.lensesforhire.co.uk

Wide range of cameras and lenses
for Canon and Nikon users to hire.

INTERFIT E
www.interfitphotographic.com
Lighting specialists who'll be showing
the battery-powered S1monolight,
and a portable LED ringlight.

KOWA OPTIMED J

www.kowaoptimed.com

Offering digiscopes and adaptors
as an alternative to long lenses for
wildlife photography.

IRIX c
www.irixlens.com

Introducing lightweight and durable
Irix wide-angle prime lenses.

LAOWA B
www.ukdigital.co.uk

Specialist lenses and macro lighting
from Chinese brand Venus Optics.

ISTORAGE LIMITED K
www.istorage-uk.com
Encrypted storage devices —in USB

LASTOLITE E
www.lastolite.co.uk
Backgrounds, reflectors and lighting

LENSPIMP H
www.lenspimp.com

Lens hire company specialising in
lenses for Canon and Nikon DSLRs.

LIGHT AND IMAGINATION J
www.lightandimagination.com
Training and studio hire for hobby
and pro photographers.

LIGHT BLUE SOFTWARE ‘A
www.lightbluesoftware.com

Photo business software that tracks
enquiries, manages quotes, sends

flash drive, HDD and SSD formats. modifiers in all shapes and sizes. invoices and more.
JOBY E LEE FILTERS G LOKI CAMERA GEAR c
www.joby.com www.leefilters.com www.lokicameragear.com

Home of the Gorillapod and other
innovative camera mount ideas.

JP DISTRIBUTION B
www.johnsons-photopia.co.uk
Distributors of accessory brands
including Black Rapid, Eddycam,
Pocket Wizard, Sekonic, and Syrp.

JUSTLIMITED A
www.cameraclean.co.uk

High-quality camera accessories,
including cleaning products. Will also
be giving sensor-cleaning tutorials.

KALEIDOSCOPE J
www.kaleidoscope-framing.co.uk
High-quality bespoke framing
service for photographers.

K&F CONCEPT E
www.kentfaith.com

Suppliers of flashguns, filters, bags,
tripods, microphones and more.

KENRO G
www.kenro.co.uk

Missin flashguns, NanGuang LED
lights, Marumifilters, Reflecta
projectors, and more.

Fullrange of camera filter systems,
including the LEE Bug (for GoPrao),
the Eagle Eye (for drones), the
Seven5 System for CSCsand more.

Innovative and ultra-portable
camera rig and shoulder mount that
lets you shoot smooth handheld
movie footage with an SLR or CSC.

LENCARTA F
www.lencarta.com

Studio flash lighting and accessories
including the portable Safari 2, and

the SuperFast high-speed flash head.

LOMOGRAPHY E
www.lomography.com

Retro-inspired cameras for the
fashion-conscious film user, plus the
brass-encased Petzval lens for DSLRs.

PRIME CANDIDATES

Lenses get big on bokeh

Primes are lenses are back and more
popular than ever, with new and exciting

glassware fromnew and exciting

companies.... and there are faster zooms
too. Faster, wider-aperture lenses give
you better bokeh and more atmospheric |
images. It's what delivers that intangible
‘look” that distinguishes you from the

ubiquitous ‘iphonographer’.

www.photographyshow.com - 33



SHOW DEALS

ON ALL THESE BRANDS AND MORE!

FUJIFILM SONY owmrPus Canon Panasonic Lexar
rlg\weprn' SIGMA irorouicur  [Nj§SN dotocolormmmm SAMYANG .
®vancuare  MEFOTO" EPSON’ 4westcott. HHOYA @tamrac:
TAMRON DOMME Cactus RODE &esirRul Velbon

U TENBA -)aemo m Herumrier MQEE 2
CBLACKRAPID 1109984 Thing pesk JBsion

Time for anupgrade?

Hunt through your drawers, open those cupboards and get yourself up in the loft.
MOW is the time to have a clearout and UPGRADE at the BEST show prices

We Buy... Digital or Film/analogue | DSLR | CSC/ILC/Mirrorless

Rangefinder/Advanced Compact | Medium Format | Lenses AF/MF | Flash/
Lighting Camera Bags/Tripods | Major Accessories | all brands considered
- as long as they're in fully working order, desirable condition and

complete ..and we're SO easy to deal with - really!

RING ALONG
3ounuuw NTED

PHOTO EQUIPMENT

wﬂ II.]. p.a.y 10}’“ Eﬂnhon
1op of our usually high
quotes at the ShOW

cameraworld.co.uk ¥ f



LONDON CAMERA E
EXCHANGE
www.lcegroup.co.uk

Visit the stand for fantastic show

MAGMOD E
www.magnetmod.com

Ninja-fast system of flash modifiers
anddiffusersthat attach to your

deals from the major manufacturers. strobe using magnets.

LONDON CAMERA K MANFROTTO E
EXCHANGE GALLERY www.manfrotto.co.uk
www.lcegroup.co.uk Designs and makes a wide range of
Exhibition of images shot by the staff accessories for photographers and
of LCE's camera stores. videographers of all abilities.

NATIONAL TRUST B
www.nationaltrust.org.uk

Check out special membership
offers at this year's show.

NATURAL TRAVEL H
COLLECTION
www.wildlifeworldwide.com

Wildlife watching holiday specialists,
with organised trips around the globe
and tailored options to suit you.

LONGRIDGE MOUNT J
CUTTERS

www.longridge.co.uk

Bevel mount cutting systems for
easy cutting of mounting board,
mats and more.

LOWEPRO E
www.lowepro.co.uk

Functional bags in all shapes and
sizes = from backpacks to rollers,
from pouches to slings, and from
hard casestodrone protectors.

LOXLEY COLOUR F G
www.loxleycolour.com

Offers awide choice of creative
printed products for the serious and
professional photographer.

LUMAPIX K
www.lumapix.com

Digital layout solutions to help create
stunning-looking photobooks, year
books, and web albums.

LUMECUBE H
www.lumecube.com

Portable, durable and powerful lights
for photography and video.

LUXS G
www.luxs.biz

From backgrounds to lighting to
props to consumables, studio and
location photography is covered.

MAC GROUP E
Www.macgroupeu.com

Trade suppliers of Benro, Induro,
MEFoto, Tenba and Vi filters. Will
demo Phottix flash accessories.

MARTIN NEWTON K
PHOTOGRAPHY
martinnewtonphotographytraining.com
Photographer offering workshops,
training and photo holidays.

THE MASTER PHOTOGRAPHERS
ASSOCIATION H
www.thempa.com

International not-for-profit
organisation, committed to raising
the standards of photography.

MEFOTO E
www.mefoto.com

Travel tripods in a range of materials,
construction, features and colours.

MIOPS TRIGGER J
WWw.miops.com

Smart triggers and remotes for
DSLRs and other cameras.

MOO C

www.moo.com/uk

Cards available in a range of shapes,
including business cards, postcard
sizes and the original minicard.

NEC c
www.nec-display-solutions.com
Leading European manufacturer
of monitors and displays.

NEST B
www.nest-style.com

Offers arange of high-tech tripods,
monopods, heads and camera bags.

NEWBORN ART G
PHOTOGRAPHY TRAINING
www.newbornartacademy.co.uk
Photograph babies professionally
with training from experienced pro
Tobias Robins.

NIKON c C
www.nikon.co.uk

Check out Nikon's full range of
cameras and lenses, plus the new
KeyMissionrange, and listen to
some big-name speakers.

NISI FILTER B
www.nisidigital.com/en
Aninternational new brand in the
camera filter market.

TRICKS WITHOUT MIRRORS

Fast shooting with the latest CSCs

MACWET A
www.macwet.com

Gloves with consistent grip that you
can keep onwhen using acamera.

See the cameras that bust through traditional
speed barriers to capture full-resolution

stills at 30 or even 60 frames a second. The
Olympus OM-D E-M1 Mark Il can capture
moments that would defeat evena pro

DSLR, and Panasonic’s uprated its 4K Photo
technology to offer amazing 6K, 18-megapixel
stills at 30fps fromits brand new GH5.

LumAr
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www.rotatnm.com

The Rotatrim Professional Trimmer. M."im

Made in Britain for photographers worldwide. The worlds finest roary cuting euipment since 1966

LIFE CHANGING PHOTOGRAPHY & BUSINESS TRAINING

“Ihe fist day of " This is the best

OUR SYSTEM AVERAGES our12month | hewbem Foome

training course

OVER £1200 PER SALE | ool et
(ALL ON WEEK DAYS) il previous to this)

3 “‘The NewbomaArt
The business Academy
aspect of this fraining is the
training will earn best purchase
me a proper I've made, it's

income ™ life changing”’

v B 01793 644668
" 1’4?///ART Learn more at
ACADEMY www . newbornartacademy.co.uk
Grow your business today or Text ‘Art’' to 80818

Visit our stand at The Photography Show 2017 - Stand G122



18-21 MARCH 2017
THE MEC, BIRMIMGHAM

Pgot wgraphy

NOMAD OF MARKET A
HARBOROUGH
www.nomadcases.co.uk

Check out the NOMAD print box,
along with aluminium cases,
rucksacks, pick-and-pluck foam bags
and other coolitems.

NOVACHROME H
www.novachrome.co.uk

Suppliers of sublimation printing
equipment used for printing onto a
wide range of substrates.

NOVO B
www.novo-photo.com

Specialists intripods, heads,
monopods and hard cases.

nPHOTO B
www.nphoto.co.uk

nPhoto produces high-quality photo
albums and photo books for pros.

N-PHOTO F
www.facebook.com/nphotomag
N-Photo is the award-winning
independent magazine for Nikon
photographers.

OLYMPUS UK D
www.olympus.co.uk

Try outthe latestsin the OM-D line-up
of CSCs, offering brilliant image quality,
high speed and creative optionsina
timeless design.

OPTICS TRIPOD CHAIRS 'C
www.opticstripodchair.co.uk
Ingenious foldable chair that has a
built-in tripod - ideal for wildlife

photography.

ORANGEMONKIE H
www.orangemonkie.com

Makers of the Foldio all-in-one
portable product studio and the
360° VR turntable.

OUTDOOR PHOTOGRAPHY J
outdoorphotographymagazine.co.uk
UK magazine for photographers
passionate about being in the wild.

PAGB G
www.thepagh.org.uk

The Photographic Alliance of Great
Britain coordinates activities across
photographic clubs through the UK.

PALETTE GEAR C
www.palettegear.com

Offers adial, button and slide-based
personalised controller system for
faster editing.

PENTAX D
www.ricoh-imaging.co.uk

Come see Pentax’s latest full-frame,
medium-format and crop-factor
SLRs and lenses.

PANASONIC D
www.panasonic.com/uk

See the latest cameras and lensesin
the Lumix Grange - including the
all-new flagship GH5.

PERMAJET F
www.permajet.com

A pioneer in continuous ink systems
and ICC colour, with the world's
biggest range of inkjet papers.

PANZER CASES F

PHOTOBOOK CONCEPT ‘A

WWW.panzercases.co.uk www.photobookconcept.com
Tough, waterproof camera-gear Innovative photo book-creation
protection. service.
PARAMO G PHOTOBOOTH SUPPLY CO'C
www.paramo-clothing.com/en-in www.photoboothsupplyco.com
High-performance directional Portable photobooths that can be
waterproof clothing for those set up by just one person.
working outdoors.

PHOTOBOOTHS c
PATERSON A www.photobooths.co.uk
PHOTOGRAPHICLTD Europe's biggest manufacturer and
www.patersonphotographic.com supplier of novelty photobooths.

Best-known for its darkroom
equipment and its Benbo range of
tripods, Paterson manufactures all
its products inthe West Midlands.

PEAK DESIGN E
www.peakdesign.com

Launched in 2011 through a
Kickstarter campaign for its Capture
Camera Clip, Peak Design now make
awhole range of bags, straps and
clips to carry your camera safely.

PHOTOFINCA K
www.photofinca.com
Photography holidays in great
locations, working with carefully
selected models.

PHOTOGRAPHY WEEK F
www.facebook.com/PhotographyWeek
Best-selling weekly photography
magazine for iPad, iPhone, Android
and other digital devices.

OLD IS THE NEW NEW

The latest designs are all retro

Discover the cameras that combine traditional
camera design with cutting edge tech. The
Olympus PEN-F looks just like the old PEN-F
half-frame camera but packs in Olympus's
latest 20-megapixel sensor and 5-axis image
stabilisation, while the Fuijifilm X-T2 offers
traditional external shutter speed and aperture
controls with Fujifilm’s famed 24-megapixel

X-Trans sensor,
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Leading imaging products

from Flaghead Photographic Ltd

at The Photography Show 18-21 March 2017

T AGnder

Quality, all metal manual focus
lenses for M Mount, Micro Four

Thirds and DSLR. ‘

Tether Tools total
workflow solution for
tethered photography,

wired or wireless.

TETHER TOOLS

HEDLER

Systemlicht

4

NEW: Tether Tools CaseAir (CASE
Wireless Tethering System
* Wirelessly tether to phone, tablet, laptop, A I R\\\

PC or Mac device.

Continuous * Remote camera control, many camera  [G—U,
lighting: function including focus, exposure, :1 '
HMI, LED and aperture, shutter, ISO and many more. -
Tungsten. * Wireless range of 150 feet (45m). ;'!)" L

* Only £178.80 incl. VAT o

L]
TETHER TOOLS
&

Camera trigger using IR beam, sound
and light intensity. Also triggers flash
units & other devices.

G

HONLPHOTO

——PROFESSIONAL——

Light shaping
accessories for your
Speedlite. Simple in
design, simple to use
and highly portable.

(B",ustom

rackets

£°98 €

A wide range of high
quality camera and
flash brackets.

GuANTUM

Turbo batteries,
Qflash and
LED Ringlite.

Visit us on stand G92 - www.flaghead.co.uk




PHOTOGUARD A
www.photoguard.co.uk

Insurance cover to suit everyone,
from full time professionals to
enthusiasts.

PHOTOKRAFFT H
www.photokrafft.com

Over 35 years experience producing
handmade albus and photobooks for
pro photographers.

PHOTO-ME B
www.photo-me.co.uk

Makes, sells and operates
photobooths, photographic fun
products, digital printing kiosks and
children's rides.

PHOTOPLUS F
www.facebook.com/PhotoPlusMag
The biggest and best magazine
for every Canon EOS DSLR
photographer, published by
Future Publishing.

PHOTOSHOP CREATIVE F
www.photoshopcreative.co.uk
Monthly magazine for those wanting
to learn to use Photoshop creatively.

PHOTOSHOP DIGITAL A
www.photoshopdigital.com

Leading manufactuer of handmade,
flush-mount wedding books and

digital photo albums based in Greece.

PHOTOVALUE B
www.photovalue.com

High-quality slip-in photo folders and
strut mounts... over 12 million
mounts at our manufacturing plant
in Dublin every year.

PHOTOXPORT A
www.photoxport.com

High-quality photographic products,
including printing, since 1989.

PHOT-R c
www.phot-r.com

Over 500 products for pros and
amateurs, including light stands,
booms and background kits.

PHOXITOG H
www.phoxitog.com

Plush toys that wrap around your
lens that squeak — designed to help
photograph chilidren.

PICA-GEAR c
Www.pica-gear.com

Check out the Pica-Pod, said to be the
world's most adaptable minitripod.

PICSCOUT H
www,picscout.com

Image intelligence system that lets
photographers to track down whois
using theirimages on the web.

PIXAPRO E
www.essentialphoto.co.uk
Specialist in studio-lighting
equipment and accessories, based
in Birmingham.

PIXEL H
www.lifemediagroup.co.uk/
pixel-magazine

Trade-only magazine, providing a
gateway to professional

development inall aspects of the
photography industry.

PLASTIC SANDWICH H
www.plasticsandwich.co.uk
Complete portfalio presentation
package.

PLOT-IT B
www.plot-it.co.uk

Leading supplier of wide-format
designtechnology and
consumables.

POWERVISION F
Www.powervision.me

Makers of the PowerEye and
PowerEgg drones.

PRACTICAL J
PHOTOGRAPHY
www.practicalphotography.com
Monthly magazine combining
hands-on advice, and gear reviews.

PRACTICAL PHOTOSHOP F
www.myfavouritemagazines.co.uk/
photography

The world’s best-selling monthly
Photoshop title for digital platforms,
published by Future Publishing.

PROFOTO G
www.profoto.com/uk

Top light manufacturer, used for
everything from billboards to
fashion magazines.

PRO PRINTS SOLUTIONS ‘C
www.proprintsolutions.co.uk

Supply and service Canon large-
format printers and 3D printers.

QNAP c
www.qnap.com/en-uk/

Specialist network attached storage
(NAS) drive suppliers.

REFLECMEDIA H
www.reflecmedia.com

Portable, flexible and easy-to-use
chromakey solutions to provide a
virtual studio on a budget.

REMEMBER MY BABY J
www.remembermybaby.org.uk
UK-based registered charity offering
professional photography services
for parents who have lost a baby.

FLASH GETS FASTER

Studio gear continues to evolve

The days when pros had to wait for their flash to recycle are gone. Now the
flash is waiting for you! The Profoto D2 monobloc offers flash durations as
short as 1/63,000 sec and flash recycling up to 20 times asecond. Or, if
you need even more speed and power, the Pro-10 studio generator delivers
2, 400Ws of power and can flash up to 50 times per second.
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GripTight POV Kit™ Flipside Trek Series

(Geared for off-road

Take better photos and video with The versatile Flipside Trek series protects
this versatile smartphone stabiliser. your camera and adventure gear for a day in
the outdoors. Easy access to your gear with

S r.l: h Flipside's patented design allows you to get your
I | la p O n e . gear without putting the bag down. Effortless

. carrying with suspension system and straps, plus
S N |ar|: G rl p multiple attachment points allow you to scale up
' or down the gear you carry outside of your bag.

i a

@epm@

Find out more at
lowepro.com/flipside

@201 6 DayMen Canada Acguisiion ULC

-
i

0 génnect Come see us at Stand No.E61

CHAMPIONING INNOYATION
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RICOH IMAGING D
www.ricoh-imaging.co.uk

Leading supplier of professional and
recreational imaging equipment,
which includes the Pentax brand.

RK PHOTOGRAPHIC A
www.thedarkroom.co.uk
Unique photographic accessories for

RSPB K
www.rspb.org.uk

The RSPBis the UK's biggest wildlife
conservation organisation.

SAAL DIGITAL G
www.saal-digital.de

German photo labthat produces
photobooks, posters, fine art prints,

the professional and enthusiast. calendars and more.

ROBERT WHITE G SCHNEIDER E
www.robertwhite.co.uk www.manfrotto.co.uk/
Professional photo retailer and schneider-kreuznach

importer of Ebony, Voigtlander,

High-quality Xenon-range lensesin

SIGMA IMAGING F
www.sigma-imaging-uk.com
Check out Sigma’s Global Vision
range and latest cameras, lenses
and flashguns.

SILLY JOKES J
PHOTO BOOTH PROPS
www.sillyjokes.co.uk

Bringing the UK's largest range

of photobooth props.

SIM IMAGING B
www.simimaging.co.uk
Supplier of quality photo books

Arca Swiss cameras. Nikon, Canon and Arri PL mounts. and photo albums.

ROBERT HARDING K SENSE-TECH c SIRUI c
www.robertharding.com INNOVATION WWW.Sirui.co.uk

Curated stock photos and video www.stcoptics.com/en Innovative maker of tripods and
clips of travel, nature, environment, Filter and screen protector tripod heads, monopods, video
wildlife and culture. specialists. accessories, and bags.

ROCKY NOOK J SHAPE D SJCAM C
www.rockynook.com www.shapewlb.com www.sjcamhd.uk.com

American publisher of educational Rigs, supports and other accessories Action camera manufacturer of
books on photography. for the pro videomaker. basic, elite and mini models.
RODE MICROPHONES H SHOOTOOLS B SMUGMUG H
www.sourcedistribution.co.uk www.shootools.com WWW.Smugmug.com

Premium mics and audio Italian company specialising in Enables you to create pro-looking

accessories including the
best-selling VideoMic and the new
compact VideoMicro.

ROTATRIM H
www.rotatrim.co.uk

Makers of the world's finest rotary
action precision paper and print
trimmers since 1966.

ROTOLIGHT D
www.rotolight.com

Maker of award-winning on-camera,
studio and location LED lighting,
based at Pinewood Studios.

camera clider and timelapse control
systems for filmmakers.

galleries and websites and back up
your images at the same time.

SHOOTPROOF F
www.shootproof.com

Offers an easy way to share, sell,
and print through online galleries
and mobile apps.

SNAPPERSTUFF G F
www.snapperstuff.com

Distributors of ThinkTank bags,

FLM tripod heads, LumiQuest flash
modifiers, MindShift bags and more.

PROCESSING POWER REDEFINED

ROUTLEDGE H
www.routledge.com

Book publisher best known to
photographers through the Focal
Pressimprint.

ROYAL PHOTOGRAPHIC €
SOCIETY

WWW.Ips.org

International, modern and
forward-looking organisation with a
distinguished past.

Having your cake, and eating it!

Once, there was no full-frame pro camera
that offered both high resolution and
high-speed continuous shooting. Now
there is. The Sony Alpha a99 Il delivers
42 4 megapixels at 12 frames per second,
and also boasts a highly advanced
hybrid all-phase-detection autofocus
system combining DSLR responses
with mirrorless frame coverage. Action/
sports photographers need to see this!
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R PATERSON

PHOTOGRAPHIC EQUIPMENT

NEC Photography show
18-21st March
Stand A111
The world famous Paterson Photographic

will be exhibiting our fabulous range of
British made Photographic Equipment!

@ APAPTALUX.

MINIATURE LIGHTING STUDIO

MAKE YOUR MACRO
PHOTOGRAPHY AMAZING.
Powerful and adaptive LED
lighting with wireless control.

www.adaptalux.com

Join the fastest growing

The Societies
of Photographers

Stand B60

The Societies of Photographers are a group of organisations
incorporating the interests of all aspects of photography. The
membership is open to full-time professional, semi-professional
and the serious enthusiast.

Please visit The Societies’ stand at The Photography Show
(B60) and find out how being a member could benefit you and

your business.

Visit us at The Photography Show
to receive £20 off professional
membership with The Societies of
Photographers. only available at the Show.

worldwide association for
serious photographers today

Show only offer

10 Reasons to Join:

1. Feature filled bi-monthly magazine
Professional Imagemaker.

2. Network with other photographers on
our online community.

3. Get expert advice on your imagery.

4, Monthly Image Competition.

5. Reduced Insurance Rates.

€. Free listing & online gallery on our
wabsite.

7. Qualifications by the submission of work.
8. Photography workshops, seminars and
Conventions

9, Exclusive member discounts on selected
photographic products and services.

10. Discounts on Annual Convention.

For more information on joining one of our eight Societies and how we
can help you with your photography please visit thesocieties.net



* Fun, step-by-step artist
insight every month

* Three issues for £5
when you subscribe’

- Watercolours, acrylics,
pastels, oils and more

* Interviews, features,
news and reviews
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*Subscribe at:

www.myfavouritemagazines.co.uk/paintl7
or call 0344 848 2852 and quote PAINT17



SOLE-MATES J
www.sole-mates.eu
Providing insoles to bring relief

TECCO PHOTO c
www.tecco.de
Manufacturers of high-quality

THEILEX PRESS J

www.ilex-press.com
Leading publisher of photography

to your tired feet! inkjet papers. books and other publications.
SONY UK D TENBA E THE PRINT FOUNDRY H
www.sony.co.uk www.tenba.com www.theprintfoundry.co.uk
Check out Sony’s new products A leader in soft-sided, professional Fine-art printing, mounting and
including the new a7, a6500, and camerabagssince 1977. framing services.
a99 |l cameras, and the latest
additions to the Sony lens range. TETENAL G THESOCIETIES/SWPP B
www.tetenaluk.com www.thesocieties.net
SO00D STUDIOS G Printer, darkroom and digital A group of organisations
www.soodstudio.com photography supplies - including the incorporating the interests of all
Innovative photographic printing Epson SureLab range of printers. aspects of photography.
services for you.
TETHER TOOLS G THE TRAINED EYE J
SPEED GRAPHIC G www.tethertools.com www.thetrainedeye.co.uk
www.speedgraphic.co.uk Cables and accessories for tethered Courses in wedding photography,

Accessory retailer with great deals
on Gitzo, Manfrotto, Lastolite, Think
Tank and more. Plus see demos of
Novoflex and other unusual kit

SPEOS G
www.speos-photo.com
Photographic institute offering
courses in Paris or London.

SRB F
www.srb-photographic.co.uk
Long-established UK photographic
retailer with a wide product range.

SUNBOUNCE/ H
SUNSNIPER
www.tetenaluk.com

Ssunbounce reflectors and diffusers,

plus Sunsniper action cam straps.

SYNOLOGY G
www.synology.com/en-uk
High-performance Network
Attached Storage (MAS) drives.

SYSTEM INSIGHT A
www.systeminsight.co.uk

Fast printing solutions for
photographers.

shooting with an iPad or computer.

portraiture, lighting and more.

THE CALENDAR A
COMPANY
www.thecalendarcompany.org
Calendars for the photo trade.

THEIMAGEFILE J
www.theimagefile.com

Web solution for proofing, displaying
and selling images online.

THE FLASH CENTRE D
www.theflashcentre.co.uk

The UK's leading Studio Lighting
Specialists for over 25 years.

THE GUILD OF J
PHOTOGRAPHERS
www.photoguild.co.uk

Training courses, networking,
support, insurance and discounts.

TOM MORGAN PICTURES K
Picture frame manufacturers.

TOPAZ LABS A
www.topazlabs.com
Software utilities for photographers.

TOWERGATE CAMERASURE ‘A
www.towergatecamerasure.co.uk
Wide range of insurance services.

SOF TWARE UPDATES

The latest generation of image editors

TAILORED H
www.tailoredgear.com
Buckinghamshire-based company.

TEAMWORK DIGITAL H
www.teamworkphoto.com

Aleader insoft-sided, professional
camera bags since 1977.

Find out where the latest photo-editing
technologies will take your photography next!
Serif's Affinity Photo threatens to turn the pro
image-editing market on its head - and is at

last available for both PC and Mac. Meanwhile
Topaz Labs will be showing plug-ins and presets
to give you the perfect ‘look’ with the minimum
effort. And don't miss the Adobe Theatre
events programme of seminars on Photoshop,
Lightroom and maobile image manipulation.
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TRAINING BY LUMIERE K
www.trainingbylumiere.co.uk

Part time photography training by
successful working photographers.

TRIGGERSMART G
www.flaghead.co.uk/
products/triggersmart.html
Triggering systems that use sound,
light, infrared beam, or movement to
fire your camera remotely.

TURNSPRO J
www.turnspro.com

Timelapse camera mount for
filmmakers and photographers.

UK OPTICS B
www.ukoptics.co.uk

Distributors of Laowa lenses, and of
Novo and Nest accessories.

ULTIMAT G
www.ultimatframes.com
Huge range of frames and mounts.

UNITARY STUDIOS C
www.unitarystudios.co.uk

Video producers specialising in
marketing, social media, YouTube,
short films, live events and more.

UsB2u H
www.photographers.usb2u.co.uk
Innovative supplier of USB drives.

VIEWFINDER D
PHOTOGRAPHY
www.viewfinderphotography.co.uk
Quality studio and lighting
equipment at keen prices.

VISIBLE DUST A
www.alphaodl.co.uk

Distributors of Visible Dust sensor
cleaners, Novagrade digiscope
adapters, Zenelli gimbal heads and
Kite optics.

WILDFOOT TRAVEL B
www.wildfoottravel.com
Specialist wildlife and adventure
travel company.

WORLD HERITAGE c
FOUNDATION - THE BIG

CAT SANCTUARY

www.whf.org.uk

Photo workshops that give acess to
the tigers, leopards and other cats of
the Wildlife Heritage Foundation.

VISICO J
STUDIO EQUIPMENT
WWW.visico.com

Studio lighting manufacturers.

WACOM c
www.wacom.com/en/gh

Leading maker of pen tablets,
interactive pen displays, and digital

WOMEN IN PHOTOGRAPHY H
AT UNIVERSITY OF THE
CREATIVE ARTS

WwWWw.uca.ac.uk

Promoting women photographers.

X-RITE C
www.xritephoto.eu
Distributor for X-Rite's range of

interface solutions. colour management products.
WD G YUNEEC G
www.wdc.com www.yuneec.uk

Offering photographers internal
and external hard drives.

Makers of the Breeze, Typhoon and
Tornado ranges of imaging drones.

WEDDING VIDEO ALBUMS H
www.weddingvideoalbums.co.uk
The alburn with a big difference -
playing images or videoona
customised tablet screen that look
from the outside like a photobook.

USBMAKERS.COM A
www.ushmakers.com

Branded USBs memory devices
for photographers.

VALLERRET J
PHOTOGRAPHY GLOVES
www.photographygloves.com

Gloves designed for photographers.

VANGUARD H
www.vanguardworld.co.uk

Founded in 1986, Vanguard designs
and makes high-quality accessories.

VANILLAPHOTOBOOKS G
www.vanillaphotobooks.co.uk
Quality photobooks available

at competitive prices.

VERSATRIGGER J
www.versatrigger.co.uk

Trigger your creative photography
with this high-speed trigger system.

WHITEWALL A
www.whitewall.co.uk

Wide range of high-quality printing
and photo-finishing services.

ZEISS B
www.zeiss.co.uk/cameralenses
High-quality Otus and Milvus prime
lenses for Nikon and Canon DSLRs,
and for Fujifilm and Sony CSCs).

ZENFOLIO H
www.zenfolio.com

Photo and video hosting
e-commerce platform, voted
number one by pro photographers.

PHOTOBOOKS ON PARADE

The best books for your business

Photobooks are the essential way of displaying
wedding photographs - but with so many different
finishes, how do you choose the right supplier, paper
and binding for your clients? At The Photography Show, .
of course! This is a rare chance to see awhole spectrum  §
of photo books in one place at one time, fromsuppliers B8
from across Europe — allowing you to see and touch
before you buy. Check out the new trends, too, such as
increadingly-popular layflat books and a wedding video
album ‘photobook” built around a tablet.
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Capture Birmingham sees organisations all
around the City host a series of events during
the weekend of The Photography Show...

Whether you are looking
to further improve your
photography skills, or

to be inspired by other
photographers, the city's
photography community
will offer a range of photo

walks, workshops and gallery

exhibitions to add a little
extra zest to your stay.

JEAN PAINLEVE EXHIBITION
Ikon Gallery, Brindleyplace

The first UK exhibition of
work by pioneering French
film director and biologist
Jean Painlevé (1902 - 1989).
His cinematographic and
photographic portraits of
octopi, lobsters, starfish and
seahorses were at the centre
of the avant-garde movement
of the 1920s.

C12 EXHIBITION AND RAFFLE
Millennium Point

All the donated prints in this
exhibition will be won as raffle
prises to raise money for the
Disabled Photographers’
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Society. Photographers include
the late Adrian Flowers, John
Claridge, Lorentz Gullachsen,
and Joe Cornish, to name a few.
Raffle tickets cost £1 each, and
the winners will be announced
on the Live Stage on Tuesday,
21 March at 13:00.

SCAVENGER HUNT LED BY
WE ALL SHOOT PHOTOS
Photographers will be split
up into teams and sent out
on a photography scavenger
hunt challenge. At the end

of the session, everyone will
finish at a venue for drinks
and networking.

SOPHIE HEDDERWICK SWIFT
AS A SHADOW EXHIBITION
Argentea Gallery, St Pauls Square
Slow shutter speed images

of ballet dancers, inspired by
Degas’ sculpture Little Dancer
Aged Fourteen.

LIGHT PAINTING AND LONG
EXPOSURE WORKSHOP

Learn new techniques for taking
long exposure photos and have
fun experimenting with light
sources. There is a £20 charge
for this event, which is run by
Mosoca Photography.

Find more information at
www.photographyshow.
com/capturebrum. Further
events hosted by other
organisations, including our
partner Visit Birmingham,
will be announced soon.

GETTING TO
THE SHOW

The NEC is 5 minutes
walk from Birmingham
International station, which
is a 10 minutes train trip
from Birmingham New
Street or 90 minutes from
London Euston. Get 25%
off Virgin Train tickets, at
www.virgintrains.co.uk/nec.

The NEC is close to
the M6, M1, M40 and M42.
Parking is £12 per day -
bookable at www.thenec.
co.uk/visitors/parking.

The NEC is just a
few minutes away from
Birmingham Airport (BHX).

There are a number
of hotels located near
the NEC itself, from
high-end to budget. Visit
photographyshow.com/
hotels for more info.

All levels of the NEC
are accessible to wheelchair
users, via ramps or lifts. The
MNEC has wheelchairs and
mobility scooters available
for hire — telephone 0121
780 4141 to book. There is
disabled parking close to the
venue. If you require a carer
ticket, please call our free
hotline on 0800 640 5001.
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ENGE

Manfrotto

Z
Flashgun

Softboxes

Lastoll!:!

i — www.manfrotto.co.
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